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Welcome
This guide describes how authors can create questions and assessments with Questionmark OnDemand
(hosted solution) or Questionmark Perception (behind your own firewall installation).
Authoring questions is the first stage in the process of using Questionmark to deploy sophisticated
assessments. The three other stages are Scheduling, Delivering, and Reporting.
This guide is intended for authors and managers of authors
who want to learn more about the process of authoring
assessments in Perception. The guide describes how authors
can use the different tools provided with Perception to create
the questions that form the basis of assessments, and to
create complete assessments ready to be scheduled and
delivered.
Please refer to Finding more information if you would like to
learn more about Scheduling, Delivering, and Reporting on
assessments with Perception.

Please note, that this guide covers all versions of Perception 5, from 5.1 to 5.4. Because of this,
some of the images may appear slightly different to the application you are using.

How is this guide organized?
If you already have some familiarity with the authoring process in Perception, you may choose to skip
straight to the area of this guide that is most relevant to you. An overview of every section in the guide is
provided below.
Chapter
See "Introduction"
on page 9
See "Questions" on
page 19

Description
An introduction to Questionmark Perception, and an overview of the authoring
process in general, including how to work with repositories and the different
authoring tools available
Many different types of question can be created in Perception. Depending on the
type, a question is structured into different components that enable authors to
specify exactly how the question is presented. The use of resources and content,
question outcomes, scoring, and Metatags all determine the characteristics of a
question.
This chapter provides a detailed overview of each question type, and how
questions are constructed.
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Chapter
See "Assessments"
on page 61

Description
There are four different types of assessment that can be created in Perception.
Assessments are composed of different blocks that determine the assessment
content and the manner in which it is presented.
The presentation of an assessment is also determined by the template associated
with the assessment, while the behavior of the assessment, which determines how
the participant takes the assessment, is determined by whether the assessment
uses time limits, Save As You Go, and Question by Question delivery.
This chapter discusses how the different types of assessment are structured, and
how the presentation and behavior of an assessment is specified.

See "Browser-Based The authoring tool Browser-Based Authoring is a web application that enables
Authoring" on page authors to create questions and assessments without needing to install Authoring
89
Manager. This chapter provides complete instructions on how to use BrowserBased Authoring.
See "Overview" on
page 135

A new stand alone Web-Based authoring tool ideal for Subject Matter Experts to
use collaboratively on.

See "Importing
content" on page
145

Question and assessment data can be quickly and easily imported into Perception
in several different ways.
This chapter describes the different methods of importing content into Perception.

See "Workflow" on
page 159

The way in which questions are created, reviewed and published can be controlled
by implementing a workflow that enforces the working practices of your
organization.
This chapter describes how you can use workflow to make creating questions
easier and less-error-prone.

See "Appendix" on
page 167
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The Appendix contains useful information on:


Where to find more information on particular subjects



Answers to frequently asked questions on authoring assessments



How to contact Questionmark

Introduction
This chapter provides an introduction to:


Understanding the differences in user interface



Repositories and how to work with them



The different authoring tools available to create assessments

Understanding the differences in user interface
This guide covers all version of Questionmark Perception 5. However, version 5.3 and later looks slightly
different than previous versions. This means that some of the screen shots in this guide may appear
differently than what you have on the screen in front of you.
The primary changes from 5.3 is the new portal-based user interface. This replaces the menu system
previously available. The following image shows how the user interface has changed.
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In Questionmark Perception 5.3 you can access the various features by clicking on the tab menu item
and then selecting the relevant link. While in Version 5.1 and 5.2, you would use the main menu and submenu to achieve the same navigation. Once you are in a selected feature you will notice that the
functionality remains the same and there are slight updates to the user interface. This is shown in the
image below comparing the Resource Manager views from Questionmark Perception 5.3 and 5.2.
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Repositories
A repository is a Microsoft Access, Oracle or SQL Server database containing question and assessment
data. All the information needed to Author, Schedule, Deliver and report on assessments is contained
within a repository.
A repository can be located:


On an author's computer, in which case the author is said to be working from a local repository



On another computer, in which case the author is said to be working from a shared repository.
An example of authors using a shared repository is users signed up to the Questionmark
OnDemand service.

Before you can create questions and assessments, an author must first create or open a repository.

Working with local repositories
A local repository is located on the same computer that an author is using to run Authoring Manager, and
is not accessed from a network.
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Authors can create local repositories in Authoring Manager, and use them to create questions and
assessments. If you are unfamiliar with the authoring process in Perception, you can use a local
repository to create example questions and assessments.
A local repository is a Microsoft Access database with no security features. Because of this, local
repositories should only be used for tryout and demonstration purposes. Local repositories should not be
used in production environments, and must never be used to deliver high-stakes assessments. In these
situations, a shared repository should be used.
To create a local repository:
1.

Open Authoring Manager

2.

Select File > New Repository… from the File menu

3.

This will start the Repository Creation Wizard that enables you to
create a local repository

Working with shared repositories
A shared repository is located on a computer that is located on a network and accessed with a TCP or
HTTP connection.
A shared repository is a SQL Server or Oracle database that provides secure access to the repository.
When authors access a shared repository they must log in with a username and password.
Shared repositories can only be created with the Shared Repository Manager, an application installed on
the Perception Server that manages all the shared repositories used by Perception.
For more information on how Perception Administrators can use Shared Repository Manager to create
and manage shared repositories, please refer to the Shared Repository Manager Help that can be
accessed from within Shared Repository Manager. The Shared Repository Manager Help is also available
to members of Questionmark Communities on the Questionmark Technical Support web site:
www.questionmark.com/perception/help
To access a shared repository in Authoring Manager:
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1.

Select File > Open > Open Shared Repository… option from the menu bar

2.

Specify a server and click Connect

3.

Once a connection has been made, select the repository you want to access from the drop-down
list and click OK

Working with multiple repositories
An installation of Perception Server can only access one repository at any one time. Which repository is
currently active is determined by the Shared Repository Manager.
When an author opens Authoring Manager, the author is asked which repository should be connected to.
An author can connect to any local repository, or (if they have the correct permissions) a shared
repository on the network.
In Authoring Manager, most of the actions (such as Copy and Paste) that an author can perform within a
single repository can also be performed between one repository and another. For example, an author can
move an assessment or assessment folder from one repository to another.

Authoring Tools
This chapter provides an overview of the different authoring tools available in Perception:


See "Authoring Manager" on page 14 - A powerful Windows application for creating all types of
question and assessment



See "Browser-Based Authoring" on page 16 - A Web application for creating many types of
question and assessment



Questionmark Live - A powerful web-based application designed for content harvesting from other
systems or Subject Matter Experts

Most questions and assessments in Perception are created with Authoring Manager, the most powerful
and feature-rich of the four authoring tools. With Authoring Manager, authors can create every type of
question, and can perform every task required to produce sophisticated assessments ready for scheduling
and delivery to participants.
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Authoring Manager
Authoring Manager is a powerful tool for creating Questionmark Perception
assessments.
With Authoring Manager, authors can create every type of question, and
can perform every task required to produce sophisticated assessments
ready for scheduling and delivery to participants.

This chapter provides the following overview of Authoring Manager:


Downloading and installing Authoring Manager



Connecting to a repository



Creating questions



Creating assessments



Controlling access rights

For more detailed information on using Authoring Manger, several useful resources are available. For
more details, refer to See "Finding more information" on page 167.

Downloading and installing Authoring Manager
Authoring Manager can be downloaded from the Downloads area of the Questionmark web site. Once it
has been downloaded onto the target machine, the install program can be run by double-clicking the
install program icon.
Before you install Authoring Manager, you should ensure that your system meets the minimum
requirements. For detailed instructions on installing Authoring Manager, please refer to the Authoring
Manager Install Guide.

Connecting to a repository
Once you have installed Authoring Manager, authors can connect to local or shared repositories and
begin creating questions and assessments. Authors can also create new local repositories if required.

Refer to See "Working with local repositories" on page 11 for more information on using repositories.
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Creating questions
Creating questions with Authoring Manager is easy.
Just select Add Question... from the Manage Items File menu to open
the Question Wizard. Many different types of question can be quickly
created. For more information on the types of question that can be created,
refer to See "Question types" on page 19.
The Question Wizard takes you through a series of screens that enable you
to specify all the details of your question. The screens you see depend on
the question type you select, and will typically enable you to provide a
stimulus and specify possible responses.
Having created a question with the Question Wizard, you can then use the
Question Wizard again for editing the question (or you can use the Question
Editor to do this).

Creating assessments
Creating assessments with Authoring Manager is as easy as creating the
questions that comprise them.
Just select Add Assessment... from the Assessments menu to open the
Assessment Wizard.
The Assessment Wizard is an easy and quick way to create different types of
assessment. For more information on the types of assessment that can be
created, refer to See "Assessment types" on page 61.
The Assessment Wizard takes you through a series of screens that enable
you to specify all the details of your Assessment. The screens you see
depend on the assessment type you select.
Having created a question with the Assessment Wizard, you can then use
the Assessment Editor to edit the assessment.

Controlling access rights
This chapter describes how managers of Perception authors can use Authoring Manager to control the
access rights given to authors. This can restrict the interactions that authors have with shared
repositories. (If you are using a local repository, access rights cannot be controlled.)
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An author's access to the following can be controlled:


Root topics (not sub-topics)



Top-level assessment folders (not sub-folders)

For example, you may wish to enforce specific access rights that enable some authors to view, edit or
delete content in certain root topics and top-level assessment folders, but forbid them from viewing,
editing or deleting content in others.
For detailed instructions on how to assign access rights in Authoring Manager, please refer to the Security
chapter of the Authoring Manager Help. This can be accessed from within Authoring Manager, or
alternatively you view a copy by clicking below.
Authoring Manager Help

Browser-Based Authoring
Browser-Based Authoring is a web application that enables authors to create questions and assessments
without needing to install Authoring Manager. If an author has been given permission to use BrowserBased Authoring, only an Internet connection and a web browser is required.
Once logged in, to access Browser-Based Authoring click Authoring from the menu across the top of the
screen. The author will then be given the opportunity to use one of four tools (the number of tools shown
depends on the permissions the author has).

Each tool is described below.
Component
Question
Manager
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Description
Enables authors to create, edit and delete topics and questions. It is also possible to
preview questions to see how they will appear to the participant. Authors can also set
security permissions for topics.

Component
Assessment
Manager

Resource
Manager

Translation
Manager

Description
Enables authors to create, edit and delete assessments. It is also possible to preview
most types of questions to see how they will appear to the participant. Authors can also
set security permissions for assessment folders and set scheduling permissions for
assessments.
Enables authors to add, replace and remove topic resources and global resources in the
shared repository. It is also possible to preview resources before using them in
questions and assessments.
Enables authors to create and manage translations of questions and assessments.

For instructions on how to use each of the above tools, please refer to See "Browser-Based Authoring" on
page 89.
Perception administrators can use Enterprise Manager to control an author's access to Question Manager,
Assessment Manager, Resource Manager and Translation Manager. For instructions on how to control
access, please refer to the Enterprise Manager User Guide.

Questionmark Live
Questionmark Live combines ease of use and speed to success to provide a powerful content harvesting
tool that allows Subject Matter Experts to:


Create an unlimited number of questions



Choose from 10 different commonly-used question types



Add images, links, feedback and more



Import items from Questionmark Perception item banks



Share questions with other authors or SMEs for review or editing



View a question's full revision history, compare revisions, and roll back to a previous version

Using Questionmark Live, SMEs can:


Establish question sets focusing on a similar theme, subject or purpose



Create questions by following simple prompts



Enter feedback for each question choice



Add comment boxes to questions



Share question sets with other authors or SMEs for review or editing



Review and select final versions of questions



Export or email questions to a Perception author



Questions are now ready to be imported to Perception



Organize questions into complete assessments
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For further information, please refer to the Questionmark Live chapter.
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Questions
This chapter describes how questions are organized and constructed. It is divided into:


See "Question types" on page 19



See "Question structure" on page 40



See "Topics" on page 43



See "Question outcomes" on page 45



See "Scoring questions" on page 47



See "Resources and content objects" on page 50



See "Special Character Palettes" on page 54



See "Mathematical equations" on page 54



See "Metatags" on page 55



See "Participant comments" on page 58

Question types
The following types of question can be included in assessments:


See "Adobe Captivate" on page 20



See "Adobe Flash" on page 26



See "Drag and Drop" on page 27



See "Essay" on page 28



See "Explanation" on page 28



See "File Upload" on page 29



See "Fill in Blanks" on page 30



See "Hotspot" on page 30



See "Knowledge Matrix" on page 31



See "Likert Scale" on page 32



See "Matching" on page 33



See "Multiple Choice" on page 33



See "Multiple Response" on page 34



See "Numeric" on page 34



See "Pull-down List" on page 34



See "Ranking" on page 35



See "Select a Blank" on page 35



Spoken Response



See "Survey Matrix" on page 38



See "Text Match" on page 39



See "True/False" on page 39



See "Yes/No" on page 39
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This chapter describes each type of question. However, it is important to know that not all question types
can be created using the Authoring Tools listed in this guide. The following matrix shows which
applications can create which question types.
Question Type

Authoring Manager

Questionmark Live

Browser-Based Authoring

Adobe Captivate
Adobe Flash
Drag and Drop
Essay
Explanation
File Upload
Fill in Blanks
Hotspot
Knowledge Matrix
Likert Scale
Matching
Multiple Choice
Multiple Response

**

Numeric
Pull-down List
Ranking
Select a Blank
Spoken Response *
Survey Matrix
Text Match
True/False
Yes/No
* Please note that the WIMBA VOICE connection is no longer being maintained by Wimba Inc. and has
been included for backwards compatibility.
** Please note that Questionmark Live classes Multiple Response (right/wrong) and Multiple Response
(score per choice) as two separate question types.

Adobe Captivate
An Adobe Captivate question allows highly interactive simulation-type questions to be answered
by the participant.
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For example, an Adobe Captivate question might provide a simulation of an application and then test the
participant's knowledge of that application. Or it might provide a presentation about safety at work, with
a series of screens showing a person operating an industrial machine, with pauses between screens to
allow the participant time to respond to questions.

Questionmark has worked closely with Adobe to integrate Captivate content with Perception. This enables
Perception to record results in the repository from interactive Captivate content.
This section contains guidance on:


Configuring Captivate movies



Creating Adobe Captivate questions



Scoring Adobe Captivate questions



Delivering Captivate movies in assessments

We assume that you are already familiar with using Adobe Captivate to create movies. For detailed
information on how to use Adobe Captivate, please refer to the Help that accompanies the product. In
addition, the Adobe Captivate 3 User Guide can be found here:
http://help.adobe.com/en_US/Captivate/3.0/captivate_3_help.pdf

Configuring Captivate movies
To publish a Captivate movie that can be used in an Adobe Captivate question, the Captivate application
will need to be configured to work with Perception. Once Captivate has been correctly configured, a
QML file that can be imported into Perception will be produced when a movie is created.
To configure the Captivate application:
1.

Open Adobe Captivate

2.

From the Quiz menu, expand Quiz Preferences and select Quiz Preferences
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3.

Under Quiz, select Reporting

4.

Tick Enable reporting for this project

5.

Under Learning Management System (LMS), select Questionmark Perception

6.

Specify the way in which you would like the results passed to Perception

7.



Under Report Pass or Fail, specify what you would like to be reported in Perception



Under Choose Report Data, select the data you would like to pass to Perception



Under Report Score to LMS, set how you would like the score to be passed to Perception



Under Reporting Level, choose whether you would like all interactions passed to
Perception or just the score

Under Quiz, select Settings
If desired, you can update the settings in this tab to customize the way that participants are able
to navigate through the movie. You can also choose to show the score at the end of the Captivate
movie, and show the progress the participant has made through the movie.

It is recommended that you do not show the score at the end of the quiz because Perception will
also do this. If you have questions in an assessment from both a Captivate movie and others
created by Perception, then the score shown in the movie will only represent the Captivate movie
score.
8.
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Under Quiz, select Pass or Fail

If desired, you can update the settings in this tab to customize Pass/Fail options. For example, you
can identify the points or percentage required for Captivate to send results as passed or failed to
Perception. You can also set what the following slide should be, if for example you are using three
or more questions you can choose to skip a question if the participant answered a question
incorrectly.
If you choose to skip one or more questions, Captivate will pass on to Perception that the question
was not attempted.
9.

Under Quiz, select Default Labels
If desired, you can update the settings in this tab to customize the messages and buttons that
Captivate displays to the participant. What you choose to show here will depend on how you
intend a participant to navigate through the Captivate questions

The question from the above example has been set to only show a user when they were correct or
incorrect. Since the question was only designed for one attempt, the retry message has not been
used, likewise, the question has to be answered before the participant can move on so the
incomplete message and the timeout message have also been disabled.
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Creating Adobe Captivate questions
Captivate movies created for use with Perception include the simulation or questions in an SWF file, along
with a QML file. To create an Adobe Captivate question, you will need to import the QML file into
Perception. To do so:
1.

Open Authoring Manager

2.

Select Add Question... from the Manage Items menu to open the Question Wizard

3.

Select Adobe Captivate from the list of question types

4.

Enter a stimulus for the question

5.

This may include a question that the participant needs to answer, or background information for
the Captivate simulation

6.

Specify the location of the QML file for your Captivate movie and click Open
Note that the QML file and SWF file must be located in the same folder

7.

Add a description of the question so that you know which Captivate movie the question refers to.
This description will also appear in the reports generated for this question

The question containing the Captivate movie will now be available for you to include in an assessment. If
you wish, you can edit the question before using it in assessments, but it is important to understand how
the scoring works before you do. Refer to the following section for more information on scoring.

Scoring Adobe Captivate questions
The content of the QML file generated by Captivate contains the following question outcomes:


A C (Correct) question outcome for passing the simulation as a whole, which is not scored and has
Evaluate other outcomes enabled



A W (Wrong) question outcome for failing the simulation as a whole, which is not scored and has
Evaluate other outcomes enabled

For each click box, text entry box, button or quiz frame in the Captivate movie, there will be a C (Correct)
question outcome for passing the interactive question, which is scored with the score set to 1 and has
Evaluate other outcomes enabled.
For each click box, text entry box, button or quiz frame in the simulation, there will be a W (Wrong)
question outcome for failing the interactive question, which is scored with the score set to 0 and has
Evaluate other outcomes enabled.
Whether a participant passes or fails the simulation as a whole is defined by the settings made in
Captivate, and the appropriate result (C or W) is passed to Perception after the participant has worked
through the simulation. Similarly, whether a participant passes or fails a particular interactive question in
the simulation is defined by the settings made in Captivate, and the appropriate result (C or W) is passed
to Perception after the participant has worked through the simulation.
Two question outcomes will be generated by Captivate for each interactive question (more will be
generated for questions containing more than one answer or possible answers), even if the slide in which
the question is included never appears (i.e. because it is skipped over). Below is an example of a
question created by importing a .qml file generated by Captivate.
The contents of an example QML file generated by Captivate is provided below.
<?xml version="1.0" standalone="no"?>
<!DOCTYPE QML SYSTEM "QML_V3.dtd">
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<QML>
<QUESTION DESCRIPTION="ExampleQuestions2" TYPE="text/plain" >
<ANSWER QTYPE="FLASH" COMMENT="Y" SHUFFLE="N">
<CHOICE ID="ExampleQuestions2">
<CONTENT WIDTH="720" HEIGHT="564" TYPE="NULL">ExampleQuestions2</CONTENT>
</CHOICE>
<CHOICE ID="Interaction10188" >
<OPTION>Interaction10188</OPTION>
<CONTENT TYPE="NULL">ExampleQuestions2</CONTENT>
</CHOICE>
</ANSWER>
<OUTCOME ID="Passed" CONTINUE="TRUE">
<CONDITION >"ExampleQuestions2" MATCHES NOCASE "C"</CONDITION>
<CONTENT TYPE="text/plain">You passed the simulation as a whole</CONTENT>
</OUTCOME>
<OUTCOME ID="Failed" CONTINUE="TRUE">
<CONDITION >"ExampleQuestions2" MATCHES NOCASE "W"</CONDITION>
<CONTENT TYPE="text/plain">You failed the simulation as a whole</CONTENT>
</OUTCOME>
<OUTCOME ID="Interaction10188 correct" ADD="1" CONTINUE="TRUE">
<CONDITION >"Interaction10188" MATCHES NOCASE "C" </CONDITION>
<CONTENT TYPE="text/plain">You successfully mastered Interaction10188</CONTENT>
</OUTCOME>
<OUTCOME ID="Interaction10188 wrong" ADD="0" CONTINUE="TRUE">
<CONDITION >"Interaction10188" MATCHES NOCASE "W"</CONDITION>
<CONTENT TYPE="text/plain">You did not pass Interaction10188</CONTENT>
</OUTCOME>
</QUESTION>
</QML>

Delivering Captivate movies in assessments
Participants taking assessments that contain Adobe Captivate questions MUST have the Adobe Flash
Player installed. This can be downloaded free of charge from the Adobe Web site:
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Adobe Flash
Adobe® Flash content can be used in Adobe Flash questions to dynamically illustrate a concept,
or present, evaluate and score a user interaction, and then pass the information to Perception
for collation and reporting.

Flash objects will return a Correct or Wrong wrong value as the result. Although it's not possible to
return more than two states from the object, it is possible to use alternative values rather than Correct
and Wrong. For example, you can return a percentage figure or any text value.
For more information on how Flash objects can be configured to return other results, please refer to the
following Knowledge Base article:
How do I make Adobe Flash questions within Perception that capture more information than
correct and wrong?

Requirements
To make it easier to use Flash with Perception, Adobe have provided a Flash Extension for Perception. It
provides custom versions of the Flash Learning Interaction SmartClips, a publishing template, samples,
and documentation. Which Flash Extension you should use will depend on the version of Flash you are
using. These are available to download from the Adobe Web site:
Flash MX 2004 Perception Interactions
The Flash extensions are designed to be used with Flash MX 2004 and above. If using Flash CS3 ensure
that you create your Flash Interaction using ActionScript 2.0 rather than ActionScript 3.0
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These extensions must be installed using the Extension Manager. If you do not already have the
Extension Manager, you can download it free of charge from the Adobe Web site:
www.adobe.com/exchange/em_download/
Participants taking assessments that contain Adobe Flash questions will need to have the Adobe
Flash Player installed. This can be downloaded free of charge from the Adobe Web site:

Creating Adobe Flash questions
To create an Adobe Flash question for Perception, you must first create the Flash object, and then import
it into your repository. You can do this with Authoring Manager.
You must have two files of the same file name (excluding the file extension) available in the same folder:


A Flash Object with the file extension .swf



A QML file with the file extension .qml published from Adobe® Flash™ using the Flash to QML
template

Once the question is in your repository, you can create an Adobe Flash question that uses the Flash
content.

Drag and Drop
The Drag and Drop question allows participants to place any number of graphical markers on a
background graphic to indicate the answer.

Drag and Drop questions are presented using DHTML.
Drag and Drop questions require the placing of a marker in a defined area known as a hotspot. Drag and
Drop questions use multiple hotspot areas and markers. To create a question with only one marker and
hotspot, you can create a Hotspot question.
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By default, Authoring Manager allows you to insert the coordinates for a rectangular hotspot or
define a rectangular area using the mouse. For some questions where the precise placement of a
marker is necessary, it is also possible to use other shapes for the hotspot including circles and
polygons to better define the area. For more information on how to do so, please refer to the
following Knowledge Base article:
In Drag and Drop or Hotspot questions can the hotspots be made in the shape of circles or
polygons?

Essay
The Essay question allows the participant to enter a long, free-range text answer to a question.

The answer can be scored manually by a grader within Perception, or by automatic tools outside
Perception. Unscored Essay questions can also be useful when conducting surveys.

As well as having the question stimulus displayed to participants, you can also display text inside
the Essay question text box, as well as below the text box. For more information, please refer to
the following Knowledge Base article:
How can I include initial text in Essay questions?

Explanation
Explanation questions are used to give general information at the beginning of a topic, or
provide information pertaining to following questions. There is no opportunity for data collection.
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An explanation question is a screen of text and/or graphics with a button the user presses to continue.
Such questions are not marked (that is, they get zero points).

File Upload
File Upload questions allow a participant to upload a file to Perception as a response to a
question.

The submitted file can be of any specified format. For example, in an assessment participants could be
asked to submit any of these types of document:


An essay (in the form of a Word DOC file or a TXT file)



A slideshow presentation that includes diagrams and text (in the form of a PowerPoint PPT file)



A spreadsheet (in the form of an Excel XLS file)



A graphic illustration or product brochure (in the form of an Adobe Acrobat PDF file)

File Upload questions are presented to participants with an easy-to-use file navigation, selection and
upload interface. Participants can then specify the location of the file on their computer or network.
Once the location is specified, the file is uploaded to the Perception Server, and can be manually
evaluated and scored by a grader or instructor using the Scoring Tool in Enterprise Manager. For more
information on how Perception Administrators can score File Upload questions with the Scoring Tool,
please refer to the Enterprise Manager User Guide.
In some assessment types, the participant might be required to download a file, amend it and
then upload it. To achieve this, in the stimulus of the File Upload question, include a reference to
the file that provides participants with the initial content. The participant can then upload
amended the file.
There are three outcomes for File Upload questions:


Unscored (0 score). The default feedback is 'This question has not yet been scored'



Scored (maximum score). No feedback is given



Error (0 score). The default message is 'It has not been possible to upload your file due to a
technical error'
It is not possible to present File Upload questions when delivering assessments using Save As You
Go.

Specifying the maximum file size
When a participant attempts to upload a file, the size of the specified file is checked against a setting for
the maximum file size allowed. If a participant attempts to upload a file that is larger than the setting
allows, then the file will not be uploaded.
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By default, the maximum file size allowed for uploaded files in Perception is 5MB (5120KB). Perception
Administrators can increase or decrease this limit if required. For information on how to modify the
maximum file size limit for File Upload questions, please refer to the Enterprise Manager User Guide.

Specifying allowed file types
When a participant attempts to upload a file, the extension of the file is checked against a list of
prohibited file extensions. If a participant attempts to upload a file that has an extension present in this
list, then the file will not be uploaded, and the following message will be displayed:
"Uploaded file is of a type that is not permitted"
The default list of prohibited file extensions in Perception is:
ade adp app bas bat chm class cmd com cpl crt dll exe fxp hlp hta ins isp jse lnk mda mdb mde
mdt mdw mdz msc msi msp mst ops pcd pif prf prg reg scf scr sct shb shs url vb vbe vbs wsc wsf
wsh
Perception Administrators can add or remove file extensions to this list.
If you include archive file-types in the list of allowed file types (for example, zip files), then
Perception will allow any files contained within the archive file.
For more information on how Perception Administrators can change the list of prohibited file extensions,
please refer to the Enterprise Manager User Guide.

Fill in Blanks
Fill in Blank questions allow authors to set a number of blank spaces for the participant to enter
text into, with each space scored separately.
One correct answer for each blank can be defined, and outcomes for these questions can be constructed
to add additional answers and identify any number of variations.
Fill in Blank questions are best suited to subject material where the recall of proper nouns is being tested,
or where there is little or no ambiguity about the words being asked for.

Hotspot
Hotspot questions allow participants to place a single graphical marker on a single image to
indicate the answer.
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Hotspot questions are presented using DHTML.
Hotspot questions require the placing of a marker in a defined area known as a hotspot. Drag and Drop
questions use a single hotspot area and marker. To create a question with multiple markers and
hotspots, you can create a Drag and Drop question.
By default, Authoring Manager allows you to insert the coordinates for a rectangular hotspot or
define a rectangular area using the mouse. For some questions where the precise placement of a
marker is necessary, it is also possible to use other shapes for the hotspot including circles and
polygons to better define the area. For more information on how to do so, please refer to the
following Knowledge Base article:
In Drag and Drop or Hotspot questions can the hotspots be made in the shape of circles or
polygons?

Knowledge Matrix
Knowledge Matrix questions present several multiple choice questions together, and the
participant selects one choice for each question presented.

Knowledge Matrix questions are similar to Pull-down List questions, except radio buttons are used instead
of pull-down lists.
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Likert Scale
A Likert Scale question allows a participant to select a response according to whether they agree
or disagree with a statement. Likert Scale questions are typically used in questionnaires to
obtain a participant's opinion on a subject.

Likert Scale questions are a variant of Multiple Choice questions, where the participant selects one choice
from a number of different choices, such as "strongly agree", "agree" and "strongly disagree". Choices
are weighted by number to aid analysis of the results, and between three and ten response options can
be presented.
Likert Scale questions can be created in Authoring Manager, and can use any existing Likert Scale
definition.
To define a new Likert Scale definition to use in your Likert Scale question:
1.

Open Authoring Manager

2.

Select Likert Scales Definition… from the Tools menu
The Likert Scale Definition screen is displayed
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3.

Enter the name of the new scale in the Add Scale box, and click Add

4.

Add the relevant choices into the choices box

5.

When you have completed adding your choices, click OK to create the new definition

Likert Scale definitions must have: A name, at least 3 choices and no more than 10 choices, and score (or
Weight) for each choice.

Matching
A Matching question presents two series of statements/words, and the participant must match
items from one list to items within the other list. In other words, Matching question offers the
participant a drop-down list of possible responses to a question.

Multiple Choice
In a Multiple Choice question the participant selects a single choice from a number of choices to
answer the question. The participant must select a single choice as the answer from the list of
two or more choice options presented.

Knowledge Matrix questions are similar to Multiple Choice questions, but can have many individual
questions within them, each question on a separate row, in the form of a table.
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Multiple Response
A Multiple Response question is similar to a Multiple Choice question, except that instead of
being able to select only one choice, the user is allowed to select one or more than one choice.

Multiple Response questions can be used very effectively when presenting complex material. Authors can
define any number of correct response options, and can group a number of response options together so
that the participant needs to select them all in order to answer the question correctly.
With Multiple Response questions, it is important to limit the number of answer choices a
participant can select, otherwise a participant could gain the maximum possible score for the
question just by selecting all the choices that are displayed. By limiting the number of answer
choices a participant can select, the question becomes a test of the participant's knowledge.

Numeric
In a Numeric Question, the participant answers by typing in either a whole number or a real
number. Answers can be defined within a specified range, with scores being assigned for
accuracy.

The format of Numeric questions will not accept any non-numeric characters, so it is not appropriate to
use a Numeric question if the correct answer may be given in words.
Numeric questions will ignore the use of significant figures if the answer is the same. For example, the
answer 36, 36.0 and 36.00 will be treated as the same figure. If the textual layout of numerical answers
is important, then the Text Match question type should be used. This will match answers letter for letter,
and will treat 36 and 36.0 as being different.
Asking for more than one number:
Authors can create Numeric questions that ask for the entry of more than one number. For more
information, please refer to the following Knowledge Base article:
How can I make a numeric question that asks for the entry of more than one number?

Pull-down List
Pull-down List questions enable authors to present a series of items for a number of choices
available in a drop-down menu. The participant can select from the items for each choice.
Pull-down List questions can be used as a multiple statement questions, for "True" or "False" questions or
to present several multiple choice questions on the same screen.
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Pull-down List questions are similar to Knowledge Matrix questions. The difference is that options in
Knowledge Matrix questions are presented as buttons, whereas Pull-down List questions present the
options as drop-down menus.

Ranking
Ranking questions require the participant to arrange a list of options in a particular order.

Select a Blank
A Select a Blank question invites the participant to choose the correct word or phrase from a
drop-down list that corresponds to a blank area of text.

Authors can create Select a Blank questions that ask participants not just for their response, but also how
confident they feel in their response. This can be a powerful learning tool, because by asking how
confident participants are in submitting responses, participants are encouraged to consider the
implications of selecting one particular response over others. For more information on how to add
confidence-level dimensions to questions, please refer to the following Knowledge Base article:
How can I add a confidence-level dimension to a question?
www.questionmark.com/perception/help/v4/knowledge_base/question_design/ques424.aspx
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Spoken Response
A Spoken Response question lets the participant record their answer to a question
using their voice. The answer can be scored manually by a grader within Perception.
It's also possible to use this question type to solicit opinions or suggestions on a
particular subject.
The Wimba Voice integration used by Spoken Response questions is no longer supported by
Wimba. All existing questions will continue to work and any new questions you create will also
work provided you continue to use a compatible version of Wimba Voice (6.0 and previous).
However, Questionmark cannot guarantee that the spoken response questions will continue to
work with future Wimba software releases.
Spoken Response question requires a participant using a microphone to record a response. The response
recorded can be in relation to any type of content or resource object added to the question stimulus. The
recording of the voice is passed back to an appropriate voice recording server like Wimba Voice 6.0(TM).
The recorded responses can then be graded using the Scoring Tool in Perception.

The Spoken Response question has a number of controls buttons that the participant can press to
complete specific actions. For example, record, stop and playback buttons are available.
Perception supports the Spoken Response question type which enables you to create a question that
participants answer by speaking into a microphone. Spoken Response questions are delivered using the
Horizon(R) Wimba(TM) (www.horizonwimba.com) system, and the recorded answers are stored on a
Horizon Wimba server.
In order to use Spoken Response questions you need the following:


Perception Server Version 5.1 or higher, licensed to use Spoken Response questions



A Horizon Wimba Server running Wimba 4.0.3 or higher. This needs Voice Authoring and Voice
Boards enabled. You will need to know the Wimba Server URL and the Wimba Voice Authoring ID
for this server

Participants will need:
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A suitable microphone, with headset recommended



A suitable browser and Java Virtual Machine, see www.horizonwimba.com for details

For further information about how to create a Spoken Response question, please refer to the following
Knowledge Base article:
How do I create and use questions that participants can answer by speaking into a microphone?
www.questionmark.com/perception/help/v5/knowledge_base/authoring/creating_questions/questi
on526.aspx
The following diagram describes the process of using a Spoken Response question type.

Technical Issues
The participant needs a microphone to answer the question, and Horizon Wimba recommend that you
consider a headset. The first time the participant answers a Spoken Response question, they will
download a Java applet from Horizon Wimba to record the voice. For full information on browser and
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other requirements for Horizon Wimba, and a diagnostic tool for checking browser compatibility, please
see the Wimba website at www.horizonwimba.com/support.
For higher stakes assessments, it's obviously vital that the participant is able to record correctly and
accurately. You will want to ensure that participants get a chance to practice on the same setup as they
will be taking the assessment for real to ensure that their voice is recorded correctly.
Some other issues to be aware of:


Communication between Perception and Horizon Wimba
The link between Perception and Horizon Wimba does not tell Perception that the question has
been answered. This means that when question by question delivery is used the color of the
question bullet is not changed when an answer is made. Also if you use a template setting that
forces you to answer every question before you can submit the answers, you will never be able to
submit the answers.



Save As You Go
Save As You Go (SAYG) does not work for Spoken Response questions as the answer is recorded
on the Horizon Wimba server, not on the Perception server. SAYG will continue to work for all
other questions in the assessment.



Loss of connection to Horizon Wimba Server
A connection to the Horizon Wimba Server is required, and if this fails the voice will not be
recorded.



Viewing Perception feedback
Participants cannot play back their recorded sound when viewing Perception feedback.

Survey Matrix
A Survey Matrix question type presents a series of Agree/Disagree or other Likert Scale style
questions in a table, and are typically used in questionnaires.

Participants choose one answer in each row, from a matrix of option buttons. Several lines of information
can be presented, giving much greater flexibility than a single Multiple Choice question. For example,
several statements referring to the question text can be presented, and the participant asked to identify
which ones are true.
Survey Matrix questions are logically similar to Pull-down List questions in that they allow the participant
to choose one option from a list of choices. However, in a Survey Matrix question the choices are
presented with option buttons and pull-down list questions use a drop-down menu.

38

Text Match
Text Match questions allow the participant to type in a single word or a few words to indicate
their answer. Authors define right or wrong words or phrases in advance by entering a list of
acceptable answers.

The grading logic can also allow scoring based on the presence or absence of keywords or key phrases
and check for misspellings. Authors can also use this question type to gather information, without scoring
it.
Text Match questions are similar to Fill in Blank questions.
Authors need to be careful to avoid ambiguity when creating outcome conditions for Text Match
questions, as it might be difficult to identify every correct answer if the required answer is an
adjective, emotion or general idea.
By setting the score to zero, you could use this question type to collect information. For example, if users
login by job description or department, you could use a text question at the beginning of the assessment
to ask for the participant's name. Or if you are conducting a survey, you could ask for other details.

True/False
A True/False question is a multiple choice question that asks the participant to give a "True" or
"False" answer to a question.

True/False questions are similar to Multiple Choice questions, the difference being that the True and
False choices are automatically inserted.

Yes/No
Yes/No questions ask the participant to give a "Yes" or "No" answer to a question.

Yes/No questions are similar to Multiple Choice questions, the difference being that the Yes and No
choices are automatically inserted.
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Question structure
A question has three components:


Stimulus - Matter presented to the participant that requires a response. Usually presented in the
form of a question, such as "What is the capital city of Peru?"



Choices - The options a participant can select in response to the stimulus. For example, if the
stimulus is "What is the capital city of Peru?", then the choices may be "Buenos Aires", "Rio de
Janeiro" and "Lima"



Outcomes - The outcome of the choice made by the participant. For example, if the stimulus is
"What is the capital city of Peru?", and the participant selected "Buenos Aires" as the choice, then
the outcome might be a feedback message displayed saying "Incorrect - the capital city of Peru is
Lima", and the participant receiving a score of zero for that question

The components of a question are presented to participants in the following way.

Choices have an ID and some text. It is also possible to define the height and width of the box in which
the choice appears, and to limit the text to a maximum number of characters. (Drag and Drop questions
specify the position on a background graphic that a marker graphic must be placed for a correct answer.)
A question will generally contain several choices. Every question must have at least one choice.
Each question has a type that determines how the choices are offered and what the participant does to
make a choice. For example, a Multiple Choice question requires the participant to select one of a number
of options, while a Drag and Drop question requires participants to drag marker graphics across a
background graphic and drop them at the locations that they believe represents the correct answer.
Refer to See "Question types" on page 19 for a complete list of every available question type.

40

A single outcome can include feedback and scoring, although this is not mandatory. Outcomes relate
choices to outcomes using conditions. There may be zero or more outcomes in a question, although one
outcome is created by default for every question. (It is possible to delete all outcomes, so there need not
be any). Refer to See "Question outcomes" on page 45 for more information.

Control information
Questions contain Control information that relate to the question itself. Control information can include
the following values. Refer to Editing control information for details of how to modify these settings.
Information
Question
description

Description
When questions are authored, it's possible to give them a label or description. This can
later be used to identify the question in reports.
A default question description will be set if the author does not set one directly, usually
taking the first few characters of the question wording. But it can be worth taking the
time to add meaningful question descriptions for each question, so that they are
meaningful when reporting.
The question description may be up to 200 characters in length, but cannot contain any
of the following characters: " < > #

Delivery status

Each question authored in Perception has a Delivery Status that can be modified as the
question is developed. The possible status values and their typical uses are:


Normal - The question is ready to be made available for inclusion into
assessments



Retired - The question is no longer used in assessments and is only retained for
historical purposes



Incomplete - The question is still being developed and is not ready for
participants to take



Experimental - The question is ready in experimental form.



Beta - The question is ready in beta form.

For example, if there are several people authoring a question, a status of Incomplete
can be assigned to it until it is formally released. The status can then be changed to
Normal.
A question always has one of the above status values, and will be set to Normal by
default.
Note that questions with a Delivery status of Incomplete or Retired cannot be included
in assessments.
Question notes Question notes are used by authors to record useful information and comments about a
question as it is developed. A question note can be created, updated or removed by an
author.
Each question note contains a heading (or Label), the name of the author who created it
and the date on which it was created or most recently modified. If a question is subject
to a workflow, it will have a workflow history that authors can review. Refer to See
"Workflow" on page 159 for more information.
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Metatags can also be used to classify questions. Refer to See "Metatags" on page 55 for more
information.

Editing control information
Control information for a question can be edited in Authoring Manager. To do so:
1.

Open Authoring Manager and connect to your repository

2.

Double-click the question to open the Question Editor

3.

Select Annotate from the Question menu. The following dialog box is displayed

4.

Enter a Question description and select a Delivery Status from the drop-down list. Select Notes
from the Question menu to add Question notes

5.

Click OK to update the control information

Setting the author name
The author name value contained in the Question notes is used to identify the author of a question, and
can be up to 100 characters of text.
You can see the current author name on the Windows caption at the top of the Authoring Manager
screen, and in the Created by and Edited by columns for questions in Authoring Manager.
If you are working in a local repository, or in an unsecured shared repository, the author name used can
be set from within Authoring Manager. To do so, select Tools > Options from the menu bar and enter
the name of the default author.
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Whatever you entered in the Default Author box will be displayed in the Authoring Manager Title bar, as
shown below.

If you are working in a secured, shared repository, the author name is set from the details of the author
set up when the administrator name is defined, and is not under the author's direct control (unless the
author has the capability to edit administrator details).

Topics
A topic is a group of questions that relate to a particular subject, level of difficulty, or some other
common trait. A topic can contain other topics. These are called subtopics, and are used for structuring
questions into logical groups.
A topic that appears at the top of a topic structure is called a root topic. There may be one or more
structures of topics, each with its own root topic. When a new repository is created, it need not contain
any topics, but you must create at least one root topic before you can create any questions.
By using topics and subtopics, the questions in a repository can be structured into item banks that can be
used to create assessments. Individual questions in a topics or subtopic may be included in an
assessment, or whole topics of questions may be.
This section contains important information on:


Naming topics



Structuring topics

Naming topics
It is important to consider how to name topics before building structured item banks, especially if several
authors are contributing to the topic. Topic names must be unique, and should follow a clear and
consistent naming strategy.
Example
You are creating a General Knowledge Quiz. Therefore, you create a root topic called General
Knowledge Quiz.
In your General Knowledge Quiz, you want to ask questions on three different subjects:




Current events
Famous people
US geography

You create three subtopics with these names.
On the subject of US Geography, you want to ask questions on two different subjects:


Grand Canyon



Rocky Mountains

Therefore, you create these subtopics within the US Geography subtopic.
The topic structure you create is as follows:
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General Knowledge Quiz


Current events



Famous people





...
...

US geography


Grand Canyon



Rocky Mountains

In this way, topics can be used to build up structured item banks.
In an item bank, every topic and subtopic contains either subtopics or questions, and each question
relates to a specific learning objective. Although it is possible for a topic or subtopic to contain both
subtopics and questions, this can cause confusion and is not recommended.
Because topic names are used in reporting, you should think about how you name them so that
the reports are as readable as possible.

Structuring topics
When creating a topic structure it is important to be mindful of two important concepts:


Topic outcomes



Topic security

Topic outcomes
Topic outcomes allow authors to provide topic-level feedback (as opposed to question-level feedback) to
participants based on the percentage score that they have achieved for each of the topics in an
assessment. The average score for topics can be reported in some of the reports in Perception.
For example, if a participant's score for a topic is 50% or above, the following message might be
displayed:
Well Done! You have passed this topic.
If a participant's score for a topic is below 50%, the following message might be displayed:
Sorry, but you didn't pass this topic.
For more information on using outcomes, refer to See "Question outcomes" on page 45.

Topic security
A sub-topic has the same security settings as the root topic in which it is located. This means that it is not
possible to assign different security permissions for topics and sub-topics. Any author given security
privileges to a topic will therefore also have the same privileges to the sub-topic. Conversely, any author
given security privileges to a sub-topic will be given the same security privileges to the topics it is
contained in.
A well defined topic structure is particularly important in a multiple author environment as it can ensure
that all authors know where the questions they create should be stored and that the security assigned is
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adequate. This makes it easier to review the questions and select them for inclusion within an
assessment.

Question outcomes
Question outcomes are determined by the participant's choice, and specify what the consequences of this
choice will be. For example, if the stimulus is "What is the capital city of Peru?", and the participant
selected "Buenos Aires" as the choice, then the outcome might be a feedback message displayed saying
"Incorrect - the capital city of Peru is Lima", and the participant receiving a score of zero for that
question.
An outcome can be created at the question level, the topic level, or the assessment level. Topic outcomes
and Assessment outcomes function in the same way as question outcomes, except at the topic and
assessment (rather than individual question) level. Refer to Assessment outcomes in See "Assessment
blocks" on page 62 for information on this type of outcome.
Question outcomes consist of the following elements:


Condition - This evaluates participant's answers, and links the choices they make to their score
and the feedback that is given to them. Refer to the table below for a list of the conditions
normally used for each question type



Score - This includes the score awarded to participants who make the choice related to this
outcome. It contains the Outcome ID. A question will generally contain several outcomes, and a
specific choice may be linked to more than one outcome. This element also specifies whether to:





Score the outcome



Accumulate the scores with those awarded if other outcomes are processed for the same
question choice



Evaluate other outcomes even if this outcome scored

Feedback - This is the text of the feedback given for the outcome. It may be in HTML or MathML
format, and may also include links to URLs, resources and content.

Question results are identified by which outcomes are associated with the answer. Outcomes are used
extensively in reporting to analyze and list answers to questions. These reports become much more
meaningful if the outcomes are organized and named well. Therefore, authors should create a question
outcome for each different possibility that reporting is required for.

Outcome conditions
The condition normally used when creating an outcome for a choice depend on the type of question
being created. Conditions used for each question type are listed in the table below.
Question type
Drag and Drop
Fill in blanks

Condition
Choice is in the area bounded by
Choice matches exactly
Choice matches ignoring letter case
Choice matches the text misspelled
Choice includes the text
Choice includes the text ignoring letter case
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Question type

Condition

Hotspot

Choice is in the area bounded by

Matching

Choice matches exactly

Matrix

Choice matches exactly
Choice matches ignoring letter case
Choice matches the text misspelled
Choice includes the text
Choice includes the text ignoring letter case

Multiple choice
Multiple response

Choice is selected
Choice is selected
All choices selected

Numeric

Choice is a number equal to
Choice is a number in a range from
Choice is a number greater than
Choice is a number less than

Pull-down list

Choice matches exactly

Ranking

Choice matches exactly

Select a blank

Choice matches exactly

Text match

Choice matches exactly
Choice matches ignoring letter case
Choice matches the text misspelled
Choice includes the text
Choice includes the text ignoring letter case

True/False

Choice is selected

Yes/No

Choice is selected

Some question types do not appear in the table above. This is because:
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Adobe Captivate questions are usually created with the Captivate Wizard which sets up the
outcomes automatically



Explanation questions do not need any outcomes



Essay questions usually have only basic outcomes such as a "Scored" and an "Unscored" outcome
because they are not scored at the time the participant takes them



Adobe Flash questions are usually created with the Adobe Flash Wizard which sets up the
outcomes automatically

The simple outcome conditions shown above may be combined with the logical operators AND, OR and
NOT to make a more complex condition. Authors can also create outcomes that are processed when
Anything else happens apart from answers trapped by the other outcomes. These other outcomes
Always happen regardless of any other outcomes that are processed, or outcomes that deal with a
questions that is Not answered by the participant.

Topic outcomes
Topic outcomes function in the same way as question outcomes, except at the topic (rather than
individual question) level.
You can apply the method of question outcomes to entire topics or sub-topics. With topic outcomes,
different score ranges in a topic can be assigned topic outcome names and different feedback.
Example
The following topic outcomes are created:


Less than 40% topic score = "Retake" topic outcome



40%-70% topic score = "Pass" topic outcome



More than 70% topic score = "Merit" topic outcome

By using a range of topic score outcomes, authors can ensure an appropriate response is given to the
performance of a participant. Authors may decide to have many different topic outcomes, or may not
require any. So at the end of an assessment, you can provide appropriate advice in the feedback for each
topic.

Scoring questions
Perception can implement an extremely wide range of scoring regimes for your questions. This section
will discuss the following mechanisms that support different scoring models:


Question score limits



Topic scoring



Assigning rubrics

Before discussing these methods, we will describe an example scoring scheme for a typical question.
This will illustrate the most important considerations when designing question scoring. Suppose that you
create the following Multiple Response question:
Which of these countries has a coastline?
You provide three choices:


Holland



Uganda



Kuwait

As it is a multiple response question, participants can choose just one option, any pair of options, all
three options or none at all.
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The correct answers to this question are Holland and Kuwait. A possible scoring scheme for this question
that captures every possible response is defined in the following table.
Participant response
Holland+Kuwait

Score
2

Condition
The choice '0 - Holland' is selected AND
The choice '1 - Kuwait' is selected AND
The choice '2 - Uganda' is NOT selected

Holland Only

1

The choice '0 - Holland' is selected AND
The choice '1 - Kuwait' is NOT selected AND
The choice '2 - Uganda' is NOT selected

Kuwait Only

1

The choice '0 - Holland' is NOT selected AND
The choice '1 - Kuwait' is selected AND
The choice '2 - Uganda' is NOT selected

Holland+Uganda

1

The choice '0 - Holland' is selected AND
The choice '1 - Kuwait' is NOT selected AND
The choice '2 - Uganda' is selected

Kuwait+Uganda

1

The choice '0 - Holland' is NOT selected AND
The choice '1 - Kuwait' is selected AND
The choice '2 - Uganda' is selected

All

1

The choice '0 - Holland' is selected AND
The choice '1 - Kuwait' is selected AND
The choice '2 - Uganda' is selected

Uganda Only

0

The choice '0 - Holland' is NOT selected AND
The choice '1 - Kuwait' is NOT selected AND
The choice '2 - Uganda' is selected

None

0

The choice '0 - Holland' is NOT selected AND
The choice '1 - Kuwait' is NOT selected AND
The choice '2 - Uganda' is NOT selected

You will need to create outcomes for each of the above conditions.
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With the scoring scheme above, a participant will receive a point for each correct choice but will not be
penalized for an incorrect one.

Question score limits
Perception enables authors to set question score limits. These define the following for each question:


Ceiling - This is the maximum score that can be awarded to a participant for a specific question.
If a greater value is calculated as the outcomes are processed, the "ceiling" score will override it.



Floor - This is the minimum score that can be awarded to a participant for a specific question. If a
lower value is calculated as the outcomes are processed, the "floor" score will override it.

A question can have a floor score, a ceiling score, both or neither.
In Authoring Manager, the ceiling and floor figures for question score limits can be set in the Question
Wizard or the Question Editor.

Topic scoring
Often, as well as awarding a participant an overall score, an author will want to allocate scores for
separate topics. This enables the level of knowledge that participants have in specific subject areas to
pinpointed with greater accuracy.
As well as awarding scores for individual questions, Perception will calculate an overall score for all the
questions in a given topic that a participant answers. These topic scores can be used for reporting, and
give useful information for analyzing how the performance of individual participants or groups of
participants varies by topic.
Example
The participants in one class might score well in the Computing topic, moderately well in the
Physics topic but less well in the Astronomy topic.
For another class, the students might score very well in the Physics and Astronomy topics but not
so well in the Computing topic.
Topic outcomes can be used to define ranges of topic score for which different feedback is given. They
can be associated with both topics and subtopics.
Example
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You have a sub-topic called Capital Cities, to which you add two topic outcomes:


Revise - This topic outcome applies if participants score 50% or less on the questions they
take from the Capital Cities topic. If so, they will see the feedback for the Revise topic
outcome, which advises them to revise the subject



Progress - This topic outcome applies if participants score more than 50% on the
questions they take from the Capital Cities topic. If so, they will see the feedback for the
Progress topic outcome, which tells them that they are ready to move on to other subjects

By using prerequisite scores for topics, you can enforce a Pass score for specific topics, and define what
happens when participants either achieve or fall below these scores. This allows authors to ensure that
participants do well enough in certain topics before they pass an assessment.
If at least one question is selected from a particular topic, then a prerequisite topic score can be set for
that topic. This means that participants must achieve a specified minimum score to reach the assessment
outcome. For example, you can require that participants do well enough in certain topics before they
pass an assessment. Prerequisite topic scores are set within the Assessment Outcome block. You can add
a prerequisite topic score for any, all or none of the topics whose questions are used in the assessment.

Assigning rubrics
Scoring schemes for questions that require a written response (Essay questions), or include uploading a
file (File Upload questions), do not have a strict answer key in the same way that questions that require
multiple choice or yes/no responses do. In these circumstances, where scoring questions will inevitably
involve making some subjective judgments about the quality of participants' responses, an alternative
scoring scheme, or rubric, is required.
A rubric is essentially a scoring tool for subjective assessments. It is a set of criteria and standards linked
to learning objectives that is used to assess a student's performance on papers, projects, essays, and
other assignments. Rubrics allow for standardized evaluation according to specified criteria, making
grading simpler and more transparent.
Rubrics can be created and assigned with the Scoring Tool feature of Enterprise
Manager. Enterprise Manager is a tool used by Perception administrators to
manage Perception deployments.
For more information on Enterprise Manager, please refer to the Enterprise Manager User Guide.
This guide is available to members of Questionmark Communities and is located on the Perception
Product Support site:
www.questionmark.com/perception/help/v5/product_guides/
Additionally, comprehensive guidance on how Perception administrators can use Enterprise Manager can
be found in the Help that accompanies the product.

Resources and content objects
In Perception, resources and content objects serve different purposes.
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Resources
Resources are graphic, video or sound files that are used to provide stimulus to the participant when
answering a question. For example, a question may include an audio or video file that is the subject of
the question, such as:
True or False: This piece of music was composed by Wolfgang Amadeus Mozart.
Resources can be used in the following places:


In topic outcomes



In a question stimulus



In question choices



In question feedback



In an assessment introduction



In an assessment question block introduction



In assessment outcomes



In assessment topic outcomes

By default, the following types of file can be used as resources:
.aiff .au .avi .bmp .gif .jpeg .jpg .mid .midi .mov .mp3 .mpeg .mpg .png .ram .rm .swf .wav .wmv
This list can be amended by Perception administrators. Refer to the Enterprise Manager User Guide for
more information on how Perception administrators can do so.
The following types of file cannot be used as resources:
.class .doc .htm .html .txt .pdf

Content objects
Content objects are files that provide the participant with a learning outcome. These files can be HTML
files, Microsoft Office documents or PDF files, or other documents or URLs that link to these or other
material. For example, if a participant answers a question incorrectly, then the participant may be
provided with feedback that includes a link to a PDF document containing learning material relating to the
question. For example:
Incorrect. This piece of music was not composed by Wolfgang Amadeus Mozart, but by Ludwig
Van Beethoven. For more information on the early work of Mozart, please refer to the following
document...
Content objects can be used in the following places:


In topic outcomes



In question outcomes (as part of the question feedback)



In assessment outcomes (as part of the assessment feedback)

Access to resources and content objects
Resources and content objects are classified within Perception as being either:


Global - Can be used with any question in any topic



Topic - Can be used only with questions in the same topic as the resource or content objects
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This classification enables greater control of where resources and content objects are used. Care should
be taken when deciding whether resources and content objects should be classified as global or topic
based - access to global resources and global content objects cannot be restricted by any security.
Generally, it is better to use topic resources and content objects.

Adding resources and content objects to the repository
Resources and content objects can be added directly to the repository and can then be used in questions.
Authoring Manager can also be used by authors to:


Add resources and content objects to the repository and use them later



Edit resources and content objects (with external applications)



Copy, move, rename and delete resources and content objects

Example: Adding a resource to a question
In the following example, we will use Authoring Manager to add a resource to a question. The resource
that we will add is a graphic file (gif) that will be used as the stimulus in a question.
To add the resource to the question:

52

1.

Open Authoring Manager and locate the question you want to add the resource to

2.

Double-click the question to open the Question Editor

3.

Double-click the question stimulus ("Which island is this?") to edit the stimulus

4.

On the right-hand side of the toolbar, click the Insert Picture icon

5.

Click Browse... to select the picture you want to add

6.

Click the Topic Resources, Global Resources or Add External Resource folders to specify
the location of the picture. In this example, we will add an external resource

7.

Locate the picture file on your computer and click Open

8.

Adjust the layout and spacing of the picture within the question and click OK

9.

Click OK. The Question Editor will dill display how the question will look to participants.

10.

Click Save and Exit
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Special Character Palettes
When answering Essay or Text Match questions, participants may need to enter characters that are not
available on their keyboards. For example, a participant may be required to translate a passage of text
from English to French and would therefore need to enter one or more accented characters. These
characters are not readily available to participants if they are using a standard English-language
keyboard.
To address this need, authors can enable the Special Character Palettes tool to enable participants to
enter any character they require. If Special Character Palettes has been enabled in an assessment, an
icon is displayed next to the text box for Essay and Text Match questions. If a participant clicks the icon,
the Special Character Palette is displayed.

From this palette, the participant can select the special character they require and insert it into their
answer.
If required, you can specify a different icon to display the Special Character Palette. You can also
configure the exact list of special characters that are displayed in the Special Character Palette, as well as
its size and position on the screen.
Special Character Palettes can be enabled and configured by modifying a setting in the template used by
your assessment. Templates are files that determine how screens in Perception are presented to
participants.
For more information on using templates to present assessments, please refer to the Templates
Reference Guide. This guide contains comprehensive guidance on how to modify and create template
files that can be used to present assessments that fully conform to your requirements.
The Templates Reference Guide is available to members of Questionmark Communities and is located on
the Perception Product Support site:
www.questionmark.com/perception/help/v5/product_guides/

Mathematical equations
Perception provides a sophisticated tool in Authoring Manager called the MathML Editor. This tool enables
authors to include mathematical equations of any complexity in their questions. Mathematical equation
can be built up from palettes that provide simple symbols and templates for more complex terms.
An equation is stored in the repository as both a JPEG image and in MathML format. When an equation is
displayed, the JPEG image is used, but when it is edited the MathML code itself is updated.
To use the MathML Editor to include a mathematical equation in your question:
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1.

Open Authoring Manager and connect to your repository

2.

Navigate to the topic in which you want to create your question

3.

Select Add Question... from the Manage Items menu to open the Question Wizard

4.

In the Question Stimulus screen, click the Insert Equation button
Equation screen

to open the Insert

5.

Use the toolbar provided to select the appropriate symbols, characters or templates to create your
equation

6.

Specify the resolution and font of the equation you want to create

7.

Click OK to create the equation and insert it into the question stimulus

Metatags
Metatags can be used to classify questions according to your own criteria. This section contains
information on:


Overview of metatags



Example metatags



Creating metatags



Assigning metatags
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Selecting questions by metatag

Overview of metatags
You can then build assessments from questions that meet one or more of these criteria. Examples might
be:


Classification by difficulty - Used for creating assessments from questions that are all equally
difficult. For example, a "Difficulty Level" may be set to "Easy", "Moderate" or "Difficult".



Classification by metric - Used for creating assessments from questions that all measure the same
thing. For example, recall of learned material or understanding of its meaning.



Classification by acceptability - Used for creating assessments from questions that have all been
approved for use in a specific area or by a specific organization. For example, "Approved in New
York" or "Approved by the examining committee".

Metatags are not used to classify questions by subject - this is the function of topics. Once you have
defined your metatags, you can add them to particular questions as you create or edit them.
You can define as many different metatags as you want, and each can have as many different values as
you need. You can define metatags that are mandatory (in other words, require a value), or that have
default values which apply unless set otherwise.
A question can only have one value for each tag assigned to it. You can use metatags to structure your
questions, as a way of indexing questions, and also to guide the automatic selection of questions.
Authors should always use common values for metatags. It is recommended that different authors
do not use the same tag name for different meanings. It would not be desirable, for example, for
one author to use an "Approved" tag to have one meaning in their assessments, and another
author to use the same value for a different purpose.

Example metatags
Metatags can be used to classify questions according to specific criteria. For example, the following table
describes the values given to two metatags, Difficulty and Approved.
Tag
Difficulty

Value
Easy
Moderate
Difficult

Approved

New York
Los Angeles
Florida

The example repository contains a large number of questions with values for both metatags, some with
only one and others with no tag values set. When creating an assessment, you can select the questions
according to the condition:
Difficulty = Moderate AND Approved = Florida
In this way, metatags can be used to select questions for use in assessments according to their Difficulty
or Approved value.
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Always define your topic structure before using metatags, so that topic structuring is the primary
method of organizing questions.

Creating metatags
Metatags can be created with the Metatag Definition tool in Authoring Tool. To create a metatag:
1.

Open Authoring Manager and connect to your repository

2.

In the Tools menu, select Metatag Definition…

3.

Click Add Metatag to add a metatag and Add Value to add values to it. Check the Mandatory
box to require the metatag to have a value

4.

Click OK to create the metatag

Assigning metatags
Once you have created metatags, you can assign them to your question. To do so:
1.

Open Authoring Manager and connect to your repository

2.

Under the Manage Items menu, select Edit Question > Assign Metatag...
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3.

Select the relevant metatag values and click OK

Selecting questions by metatag
Once you have defined metatags and assigned them to questions, you can create assessments that
include only questions with specific metatag values. To do so:
1.

Open Authoring Manager and connect to your repository

2.

Create your assessment

3.

Open your assessment in the Assessment Editor. To do so, simply double-click on the assessment

4.

Under the relevant question block, right-click the question selection including the questions you
want to filter by metatag and select Meta tags. (Question selections are questions, whole topics
or questions selected from within topics.) This opens the Tag Equation Editor

5.

Specify the meta tag equation that you wish to create.
For example, in the above screenshot the Approved metatag is set to equal "Florida" and the
Difficulty metatag is set to equal "Easy". By specifying an AND value, only questions with both
metatags set to these specific values will be included in the question selection

Participant comments
When a question is created, an author can specify whether to provide participants with a text box in
which to submit their feedback. This is particularly useful when beta-testing questions.
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Participant comments can be enabled by using the Question Editor in Authoring Manager or the Add
Comment Box option in Questionmark Live.

The exact wording that invites feedback can be specified or left blank. For example, the question can ask:
Do you have any comments about this question?
You can also specify the default size of the text box in Authoring Manager, or simply drag it to the
appropriate size in Questionmark Live. When participants take an assessment containing a question that
has Participant comments enabled, the Participant comments text box displayed below the question.
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The participant can enter their comments in the box before moving on.
The comments made by participants can then be reviewed by running a report with Enterprise Reporter.
For more information on Enterprise Reporter, please refer to the Enterprise Reporter User Guide.
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Assessments
This chapter describes how to create Perception assessments. It is divided into:


See "Assessment types" on page 61



See "Assessment blocks" on page 62



See "Question by Question delivery" on page 66



Scenario assessments



See "Save As You Go" on page 73



See "Time limits" on page 74



See "Printing and Scanning" on page 76



See "Printing assessments for manual scoring" on page 83



See "Templates" on page 86



See "Enabling participants to view reports" on page 87

Assessment types
An assessment can be defined as a structured set of elements, usually questions, that are presented to a
participant to obtain a response.
There are four different types of assessment that can be created. These are described in the following
table.
Assessment
type

Description

Exam

Does not give feedback, and is secured against unauthorized access

Test

Mid-way between a quiz and an exam, and feedback may be given

Quiz

Used for self-assessment, usually gives feedback, and is open to all

Survey

Asks the participant questions, does not give feedback, and has no right or wrong
answers

For details about what functionality can be applied to each of the above assessment types, please refer
to the following table.
Assessment
type

Record
answers

Provide
feedback

Allow
assessment to
be taken from
open.php

Apply a
time
limit

Set assessment
to use
Questionmark
Secure

Keep results
anonymous
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Assessment
type

Record
answers

Provide
feedback

Allow
assessment to
be taken from
open.php

Exam
Test
Quiz

Optional

Apply a
time
limit
Optional

Optional
Optional

Optional

Optional

Optional

Optional

Optional

Optional

Optional

Optional

Survey

Set assessment
to use
Questionmark
Secure

Keep results
anonymous

= Is enabled by default
= Can't be enabled
Optional = Is not available by default but can be enabled.

Assessment folders
Just as questions are organized into topics, so assessments are organized into assessment folders.
An assessment can only exist in an assessment folder. An assessment folder can contain zero or more
assessments as well as other assessment folders. An assessment folder that appears at the top of an
assessment folder structure is called a root assessment folder. There may be one or more structures of
assessment folders, each with its own root assessment folder.

Assessment blocks
Assessments are composed of blocks that determine the assessment content and the manner in which it
is presented. Each block is described in the following table.
Assessment
block
Control block

Description

This contains the settings for how the assessment is to be delivered.
There is always one Control block in an assessment

Question block

Specifies which questions are used in an assessment.
There is always at least one Question block in an assessment

Jump block

Specifies which question blocks are presented to participants according to the
answers they submit as they progress through the assessment.
There can be zero or more Jump blocks in an assessment

Assessment
outcome

Specifies what happens when participants have answered all the questions presented
to them
There is always at least one Assessment outcome in an assessment
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Each assessment block is described in more detail below. The assessment blocks in an example
assessment is also provided.

The Control block
The Control block of an assessment contains the control and security settings that specify how the
assessment is to be delivered. When an assessment is created, the Control block is automatically created.
The control settings in a Control block specify:


The assessment name



The assessment type



The assessment time limit



Whether to store results in the repository



Whether the assessment can be taken anonymously



The template file that determines how the assessment appears



Whether to use Save As You Go

The security settings in a Control block specify:


Whether the assessment requires monitoring



Whether the assessment can run from integrations



Whether the assessment requires Questionmark Secure



Whether to prevent open access to the assessment



The security password to control scheduling

Question blocks
Question blocks specify the questions and topics to use in an assessment. A question block might specify:


A single question



A selection of questions in a topic



All questions in a topic



A random number of questions picked at random from a topic



All questions with a shared metatag value in a topic



A random number of questions picked at random from questions with a shared metatag value in a
topic

You cannot save an assessment if it has no question blocks, or if a question block does not specify any
questions.
Each question block is delivered separately to the participant unless Question by Question delivery is
used, in which case a question at a time will be presented.

Jump blocks
Question blocks in an assessment are typically presented in order, until the end of an assessment is
reached. However, a Jump block can change the order in which question blocks are presented, either by
skipping forward, missing out some blocks, or else going back to re-present a previous block.
In other words, Jump blocks control how a participant proceeds through an assessment, depending on
what has happened so far. For example, a second question block may only be presented to a participant
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if the participant achieves a minimum score in the first question block. This is a powerful tool that
enables authors to create assessments that act flexibly depending on what the participant does.
Authors should take care when using Jump blocks, especially Jump blocks that take participants
back to an earlier part of an assessment, as it is possible to create undesirable situations.
For example, it is possible to create an assessment that infinitely repeats, asking some questions
and then jumping back to ask them again. Authors should thoroughly test any assessment that
uses Jump blocks prior to presenting the assessment to participants.
The scoring of an assessment can be affected in three important ways when using Jump blocks:


If an author creates a Jump block that goes backwards, and asks a question block a second time,
Perception will overwrite the first set of results with the participant's most recent performance.
This means that if the assessment results are being stored in the repository, only the participant's
most recent performance in a Question block will be stored in the repository



The total score for an assessment is the sum of the scores of all questions in all Question blocks
sent to the participant. This means that if a Jump block enables a participant to retake the
questions in a Question block, the scores for the retaken questions will count again



If a Jump block causes a participant to skip the questions in a Question block, the score for the
skipped questions does not count towards the maximum score for the assessment. For example, if
an assessment contains three Question blocks, each with a maximum score of 10 points, and a
participant answers the first Question block with a score of 10 out of 10, and then jumps to the
end of the assessment, the score for the assessment will be 10 out of 10, and not 10 out of 30

Assessment outcomes
Assessment outcomes function in the same way as Question outcomes, except at the assessment (rather
than individual question) level.
When participants have answered all the questions presented to them, their overall score for the
assessment will be calculated and then used to determine how their performance is evaluated. A range of
overall scores is used to define one or more assessment outcome. For example, an overall score of less
than 50% may be used to define a "Fail" outcome, and one of more than 50% may be used to define a
"Pass" outcome.
There is always at least one assessment outcome in an assessment. You can have up to 100 different
score bands, each applying to a different range of scores. For example, you could have one for 0-30%,
one for 31%-60% and one for 61% to 100%.
An assessment outcome can contain instructions to:


Define the range of scores for which it is applicable



Give a feedback message



Redirect the participant when the assessment ends - For example, branch to another assessment
or URL



Send a predefined email to specified recipients when the assessment ends

Prerequisite scores for topics
It is also possible require participants to achieve a minimum score in particular topics before an
assessment outcome can be met. By using prerequisite scores for topics in this way, you can enforce a
Pass score for specific topics, and define what happens when participants either achieve or fall below
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these scores. This allows authors to ensure that participants do well enough in certain topics before they
pass an assessment.
Example prerequisite score for topics
You have General Knowledge quiz that contains three topics:


Politics



Sport



History

To pass the quiz, participants must achieve:


An overall Pass mark of 75%



A Pass mark of 50% in each of the three topics

By using prerequisite scoring for topics in this way, a minimum level of performance in all three
topics (as well as an overall performance) can be required to pass the test.
Prerequisite topic scores are set within an assessment outcome block. You can add a prerequisite topic
score to an assessment outcome for any, all or none of the topics whose questions are used in the
assessment.

Example
In the following example, a simple assessment has been designed that contains two Question blocks,
each block containing ten questions with each correct answer to a question worth 1 point. Therefore the
maximum score for the assessment is 20 points, and the Pass mark is set at 16 out of 20.
It is required that the second Question block will only be presented to participants if they answer 8 or
more questions correctly in the first Question block. At the end of the assessment, if the participant has
not obtained the Pass mark, they will be given the opportunity to retake the assessment.
Based on the above, this example assessment will be composed of the following assessment blocks:


One Control block



Two question blocks



One jump block



One assessment outcome

This structure is displayed in the following diagram.
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When viewing the assessment in the Assessment Editor tool in Authoring Manager, the assessment
blocks are displayed as follows.

Question by Question delivery
When a Question block is presented, by default the first question in the Question block is displayed at the
top of the screen, and all subsequent questions are displayed underneath. Because every question in a
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Question block is displayed on the same screen, participants must scroll down to move between
questions.

This default method of presenting questions is simple and works on all browsers. However, some
organizations using Perception have found that participants find it easier when only a single question is
presented on the screen at a time. This enables the participant to concentrate fully on the current
question, answer it and then move to the next question.
One solution to having a single question on a screen is to have only one question in each Question block,
but this means that it's much harder to choose questions at random. And since it's not possible to go
back to a previous Question block and change an answer, this prevents participants from going back to
change and review answers.
An alternative method, called Question by Question delivery , is available. Here, the browser formats the
block so that each question is displayed on a single screen, and the participant can move between them.
This presents each question on its own on a single screen, and does not require the participant to scroll
between questions.
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The delivery method employed by an assessment is determined by the template it uses. As well as
specifying that an assessment should use Question by Question delivery, the template used by an
assessment also specifies the way in which Question by Question delivery should be presented. For
example, by modifying the settings in a template, an author can change the layout of the screen, modify
the graphics and labels used, as well as include or remove certain functionality such as the Flag, Help and
Proceed buttons.
Refer to See "Templates" on page 86 for more information on how to modify the presentation of
assessments.

Disabling navigation between questions
Using Question by Question delivery, it is possible to present questions one at a time. But Question by
Question delivery also allows participants to flag questions or navigate to previous questions to allow
them to change their answer.
In some situations this may not be desirable. To address this issue, it is possible to limit the ability of
participants to navigate between questions. It is also possible to ensure that the question has been
answered before it can be submitted.
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To make these changes, you will need to modify the template file used by your assessment. For more
information on using templates to present assessments, please refer to the Templates Reference Guide.
This guide contains comprehensive guidance on how to modify and create template files that can be used
to present assessments that fully conform to your requirements. The Templates Reference Guide is
available to members of Questionmark Communities and is located on the Perception Product Support
site:www.questionmark.com/perception/help/v5/product_guides/

Placing questions within separate Question blocks
To limit a participants' ability to navigate between questions, and ensure that the question is answered
before it is submitted, you will need to modify the template used by the assessment in the manner
described above, You will also need to ensure that all the questions contained within the assessment are
placed in their own questions blocks. For example, the following screenshot shows each question
contained within separate Question blocks in the Assessment Editor in Authoring Manager.

Scenario assessments
Perception has the ability to create assessments that have multiple questions based on a single stimulus.
This is sometimes known as:


Scenario-based assessments



Case questions

Scenario-based assessments can be beneficial to organizations wishing to test a participants
understanding of a specific subject or gauging how a participant would react in certain circumstances.
Perception Version 5 ships with a template specifically designed to show Scenario-based assessments. It
is called qxqIntroFixed and looks like the following to a participant:

69

It is possible to alter any QXQ template so that it shows the static text stimulus. For instructions about
how this can be done, please refer to the following Knowledge Base article:
How can I add a static stimulus section to a QXQ template?
http://www.questionmark.com/perception/help/v5/knowledge_base/authoring/working_with_temp
lates/template512.aspx
A single stimulus can be created for each Question Block in an assessment as per the example below
and the stimulus will appear until all the questions from the specific Question Block have been answered.

The Question Block introduction is the text that is shown in the stimulus, this is why the stimulus will only
appear for questions contained in the same Question Block within an assessment.
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Creating questions
In general when building scenario-based assessments it is a good idea to have already created the
scenario you want to assess. This will help ensure that the questions remain focused and are relevant.
You can create questions as you would any normal set of questions. Group them in a single sub-topic or
place the questions in other relevant topics. For instructions about how to create questions, please refer
to Questions chapter.

Creating an assessment and inserting the static stimulus
To add the text you want to appear in the static block introduction you will need to create an assessment
using the Assessment Wizard.
1.

Set the name and type of assessment

2.

Set the Assessment control information and choose the template qxqIntroFixed from the
Template drop-down list

3.

Add any messages you want to include and select the questions you want to display

4.

Set any pass/fail information and finish the Assessment Wizard

Now that you have created the assessment you can go about adding the text to display in the static block
introduction. The text/graphics that are displayed in the static stimulus of an assessment are taken from
the Question Block Introduction. To add text to the Question Block introduction complete the following
steps:
1.

From the assessment folder right click on the assessment you just created and click Edit
assessment...
The Assessment Editor window will open
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2.

Right click on the Questionblock created by wizard entry and click Edit Settings...

3.

Click Introduction from the Settings menu on the left

4.

Add the text or images you want to appear in the static block introduction

5.

Click OK on all open windows and Save the changes made to the assessment

You can add additional Question Blocks to the assessment and as the assessment passes from one
question to another the text in the static block introduction will change, showing the text corresponding
to the current Question Block.
If you add additional Question Blocks but do not include any introduction text the static block
introduction will remain empty.

Save As You Go
Sometimes a participant will begin an assessment but not complete it. This may be through choice, or
because there is a system failure such as a power cut, loss of network connectivity, or software failure.
A participant's answers are recorded in the repository each time a Question block is completed.
Therefore, if a participant answers all questions in one Question block, but only answers some questions
in a second Question block, then in the event of a system failure (for example, if the participant's browser
crashes mid-way through an assessment) only the participant's answers from the first Question block will
be recorded. The participant's answers to questions in the second Question block will be lost.
By default, when they next log in to Perception, participants are given the option to resume unfinished
assessments at the point at the point where the last Question block was completed. This behavior can be
configured by Perception Administrators. For example, unfinished assessments can be automatically
resumed when participants log in to Perception, rather than if the participant chooses to resume. For
more information on how to set these delivery options, please refer to the Enterprise Manager User
Guide.
Save As You Go is a feature of Perception that enables participants to save every answer they have
given, so that they will not have to give them again if the assessment is not completed. If this happens,
the participant can log in to Perception once again and resume the assessment from their last saved
point in the assessment.
Assessments using Save As You Go can include a Save button that participants can press whenever they
want to save their progress.
The behavior of Save As You Go when saving a participant's performance can be determined by
modifying settings in the template used by the assessment. Save As You Go can be configured to:


Save answers on request (when the participant presses the Save button)



Save answers at specific timed intervals (for example, every 5 minutes)



Save answers on request as well as at timed intervals



Confirm that answers are saved before saving them

Refer to See "Templates" on page 86 for more information on how to modify the presentation of
assessments.
When an assessment has been interrupted, any answers that have been saved by the participant using
Save As You Go cannot be accessed for reporting. The answers only become available for reporting after
the participant submits them.

Enabling Save As You Go
Save As You Go must be enabled in the Control block of an assessment before it can be used. This can
be done with the Assessment Editor in Authoring Manager.
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Time limits
Authors can specify that an assessment has a time limit when it is created. In Authoring Manager, this
can be performed with the Assessment Wizard. Assessment time limits can also be modified by editing
the Control Block in the Assessment Editor.
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The time limit for an assessment is independent of the time that the assessment may be scheduled for.
The time limit applies from when the assessment starts, not from when it is scheduled.
The time taken by a participant in an assessment is counted from when the first Question block is sent to
the participant, and ends when the last Question block is submitted. If a participant stops and then
restarts an assessment, the count is not stopped or extended, but will continue until the time limit is
reached or the last Question block is submitted.
Specific Question blocks can be excluded from an assessment time limit. This can be useful when
presenting a Question block that introduces the assessment and thus does not require a time limit, or if
an un-timed rest period is required between two timed Question blocks.
Example
An author creates an assessment that includes three Question blocks. There is a two hour time
limit, but the middle block is excluded from the time period.
Participants answer questions in the first Question block, and then take an un-timed rest while the
second Question block is displayed. They then answer questions in the third Question block. The
time taken for the first and third Questions blocks is thus limited to two hours.
Feedback is also presented after each block, which is also excluded from the time limit.
Typically, if a time limit is set the time remaining is displayed and counts down in the browser window.
Additionally, a warning message is usually given five minutes (or another amount of time) before the
time is due to expire. How the time limit is displayed to the participant can be controlled by the template
used by the assessment.
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Once the time limit has expired, the current block is automatically submitted with whatever answers have
been made. The assessment is then finished and a final page with assessment outcome is displayed.
Questions in any remaining blocks are interpreted as being unanswered for scoring purposes.

Printing and Scanning
Assessments can be printed in Word or HTML form for participants to take on paper rather than online.
In this way, assessments can be printed and taken on paper, the answers also printed out, and the
scoring then performed manually. For more information on how assessments can be printed in Word or
HTML form, refer to See "Printing assessments for manual scoring" on page 83.
A more sophisticated means of delivering assessments on paper is to use Questionmark's Printing and
Scanning solution. Using Printing and Scanning, assessments created in Perception can be printed and
delivered on paper. The assessment results can then be scanned and uploaded to the Perception
database for reporting.
This section describes how authors can use Printing and Scanning to create assessments for paper
delivery, and is divided into:


How does Printing and Scanning work?



Printing an assessment with Printing and Scanning



Customizing master documents

How does Printing and Scanning work?
An assessment can be printed out from Authoring Manager onto paper using one of the Microsoft Word
template files supplied with Perception. Participants then take the assessment and submit their responses
by marking OMR (Optical Mark Recognition) bubble sheets. An example OMR bubble sheet is displayed
below.

Next, the bubble sheets are scanned, and the response data is read by the third-party scanning software.
The scanning software produces an Assessment Data File in CSV (Comma Separated Value) ASCII text
format suitable for uploading to Perception. Data from this file is uploaded to the Perception database,
and the responses can be analyzed using Enterprise Reporter in Enterprise Manager.
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What question types are supported?
The following question types can be used in Printing and Scanning assessments:


Multiple Choice



True / False



Yes / No



Likert Scale



Multiple response

Can I shuffle questions?
Printing and Scanning can accommodate shuffled answer choices. If an assessment printed out using
Printing and Scanning contains shuffled answer choices, snapshot definition data is used to handle the
data processing required. This ensures that the content of the printed assessment, and the participants'
responses that are scanned in, are fully coordinated in the Perception database.
For more information on assessment snapshots, please refer to the 'Printing and Scanning' chapter of the
Enterprise Manager User Guide.

Can I collect demographic data?
Demographic data (for example, the participant ID or department ID) can be collected by participants
marking fields on their OMR bubble sheets.

Printing an assessment with Printing and Scanning
To deliver assessments on paper with Printing and Scanning:
1.

Create the Perception assessment you want to deliver on paper

2.

In Authoring Manager, highlight the assessment and under the Assessments menu, select Print
> Print Assessment for Scanning
The Print Assessment for Scanning screen is displayed
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3.

Select the print option you require. These options are described in Print options below

4.

Check Include multiple response questions if you want to include Multiple Response
questions in the printed assessment

5.

If Block Introductions options are available, you can select one of these options:


Display all - Display introductory text for all question blocks in the printed assessment



Display first only - Display introductory text for only the first question block in the printed
assessment



Display none - Do not display introductory text in the printed assessment

6.

In Master document, select the template you require. For more details on the master document
templates provided with Perception, please refer to Choosing a master document template

7.

If the assessment has been set to shuffle questions, you can define a randomization pattern by
entering an alphanumeric string of one to four characters in the Randomization key box. This
gives you the option of re-entering the same string in future and the printed assessment will be
identical.
If the assessment has NOT been set to shuffle questions, or you do not wish to define a
randomization key, leave this box blank

8.

To save the options you have specified, so that they will be shown the next time you open this
screen, check the Save printing options box

9.

Click Preview to ensure that the assessment displays correctly

10.

Once you are happy with the way the assessment is displayed, click Print
The assessment will be created and displayed in Word

11.
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If required, amend the title of the assessment and introductory text. It is also recommended that
you ensure that for each question the answer choices aren't split by a page break

12.

Print the assessment on to paper

Print options
The following tables describes each of the four available print options.
Print option
Question sheet that
will be accompanied
by OMR bubble sheet

Description
This is the most common option. The assessment is printed out from the
Microsoft Word application. Participants submit their responses onto
accompanying OMR bubble sheets which, after the assessment, are scanned
using an OMR scanning machine. Any type of bubble sheet can be used, but you
need to ensure your scanning software will convert the response data to the
required ASCII CSV data format, and produce an Assessment Data File in this
format.
The advantage with using this option is that the assessment sheets can be
printed using any format you require (and answer choices can be spread over two
pages).

Question and bubble
sheet to be answered
on

This option is primarily for use with Principia Remark Office software.
Assessment questions and OMR bubbles are printed from the Word application
onto blank sheets. The sheets are printed with bubbles to allow participants to
submit their responses which, after the assessment, are scanned using an OMR
scanning machine. The scanning machine uses Principia Remark Office or Classic
software, which converts the response data to the required ASCII CSV data
format, and produces an Assessment Data File in this format.
The advantages with using this option are that the assessment sheets can be
printed using any format you require (and answer choices can be spread over two
pages), and, if your scanner can read barcodes, these can be put onto the sheets
to gather further information.

Overprint question
sheet on an OMR
bubble sheet

The assessment is printed out from the MS Word application onto an OMR bubble
sheet. Participants submit their responses onto the sheets which, after the
assessment, are scanned using an OMR scanning machine. You can use any type
of bubble sheet but you need to ensure your scanning software will convert the
response data to the required ASCII CSV data format, and produce an
Assessment Data File in this format.
This option is used typically for surveys, where the:


Question stimuli are quite brief



Answer choices are the same for all questions (as the they are printed in
the header area)



Questions are not shuffled



Questions are all of the same type

A template is provided for this option that can be used with the Pearson General
Purpose Data Sheet II.
Generate XML for a

The XML code of the assessment snapshot is generated. If iexplore.exe is
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Print option
custom application

Description
specified in Application file, then a browser window will open and the XML code
will be displayed in the browser.

Choosing a master document
You can print an assessment as:


A question sheet that will be accompanied by an OMR bubble sheet



A question and bubble sheet to be answered on



An overprint question sheet on an OMR bubble sheet



XML for a custom application

For each of these formats, Questionmark have provided template files that determine the assessment
output. In Perception, these template files are known as master documents.
The following table provides a list of the master document templates supplied with Printing and Scanning.
If you have installed Authoring Manager in the default location, these files will be located in sub-folders
within the following directory:
C:\Program Files\Questionmark\Perception5\authoring\printing\ScanTemplates
Existing master documents can be customized to suit your needs. Refer to Customizing master
documents for more information.
Output format
Question sheet
with OMR bubble
sheet

Subfolder
\Standard

Master
documents
A4 with header.doc

Notes

A4 no header.doc

The standard assessment format. Assessment is
printed onto blank sheets accompanied by an
OMR bubble sheet.

Letter with
header.doc

The difference between A4 and Letter templates
are the paper size they print on.

Letter no header.doc
Question and
bubble sheet

\Principia

A4.doc
Letter.doc

Provided for Principia Remark assessments and
require two Principia fonts to be installed on the
authoring system:


OMR Bubbles



3 of 9 Barcode

These can be downloaded from the Principia Web
site. The difference between the A4 and Letter
templates are the paper size they print on.
Overprint question
sheet on OMR
bubble sheet

\Overprint

XML

Not required
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Pearson General
Purpose Data Sheet
II.doc

Can be used with the Pearson General Purpose
Data Sheet II.

Customizing master documents
You can create your own master documents by customizing the master document templates supplied
with Printing and Scanning. To create a customized master document, we suggest that you make the
required changes to a copy of an original master document. You can then use your customized master
document to print the assessment in Authoring Manager.
You can customize your master document by opening it in Microsoft Word and making the required
changes directly. For example, you may want to change the page layout, header and footers, page
numbering, or paragraph styles. You can include assessment information by adding bookmarks to your
master document that display assessment information when the assessment is printed. Refer to Adding
assessment data for a list of the bookmarks you can add.
Master documents must contain every paragraph style used by Printing and Scanning. A master
document that lacks a paragraph style will cause unpredictable results. The required styles are listed in
the table below.
Style

Defines...

qm_Block_Name

The name of each question block except the first one

qm_First_Block_Name

The name of the first question block

qm_Introduction_Text

The introduction text for each block

qm_Question

All available questions

qm_EndOfQuestion

The empty paragraph that marks where one question ends and the next begins

qm_Explanation

Any explanations included in the assessment

qm_Comment

The label for any comments included in the assessment

qm_AnswerSpace

The answer space for comments

qm_MC_Bubble

Multiple Choice options when bubbles are included. The bubbles for Multiple
Choice options when bubbles are included

qm_MC_NoBubble

The choices for Multiple Choice options when bubbles are NOT included

qm_MC_CorrectAnswer The choices for Multiple Choice options when correct answers are included. The
bubbles for Multiple Choice options when correct answers are included
qm_MR_Bubble

Multiple Response choices when bubbles are included. The bubbles for Multiple
Response choices when bubbles are included

qm_MR_NoBubble

The choices for Multiple Response choices when bubbles are NOT included

qm_MR_CorrectAnswer The choices for Multiple Response choices when correct answers are included.
The bubbles for Multiple Response choices when correct answers are included
qm_Scoring

The instructions for scoring an individual question

qm_AssessmentScoring The instructions for scoring an entire assessment
qm_OMR_bubble

The OMR font style for question choices. Used by Principia

qm_QuestionNum

Style of question description when displayed in table format

qm_Legend

Style of question choice legend when displayed in table format
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Style
qm_NormalMR

Defines...
Style of table column heading for multiple response questions

Adding assessment data
When printing assessments for scanning, question block content is added beneath any existing material
at the top of the first page of the master document and subsequently for as many pages as needed.
Assessment scoring information (if included in the output) is added where the final question block ends.
You may wish to include information at the top of the first page of the master document. One way of
doing so is by adding bookmarks that display assessment information when the assessment is printed.
To include bookmarks within your master document, place the cursor where you want the information to
appear and select Insert>Bookmark... from the File Menu in Word.
Word requires every bookmark name to be unique. Therefore, if you've already inserted a bookmark in
one location and want to insert it somewhere else, add to the name a digit from 1 to 9 to make the name
unique. For example, if you've already inserted a bookmark called qmAssessment_ID and you want to
insert it in another location, enter qmAssessment_ID1 as the name.
The following table lists the bookmarks you can add to a master document.
Bookmark

Specifies...

qmAssessment_ID

The unique ID of the assessment

qmSnapshot_ID

The unique Snapshot ID of the assessment

qmRandom_Key

The key used for random selection, shuffling, etc.

qmAssessment_Type

The type of assessment

qmName

The assessment name

qmDescription

The assessment description

qmAuthor

The name or ID of the person who created the assessment

qmSave_Answers

If the results are saved to the answer database

qmSave_Answer_Data

If the full answer data is saved to the answer database

qmNumber_Of_Blocks

The number of question blocks in the assessment

qmNumber_Of_Questions

The of number of questions in the assessment

qmTime_Limit

Time limit in minutes

qmPreviewMessage

A warning message

qmChoice1

First question choice for bubblesheet

qmChoice2

Second question choice for bubblesheet

qmChoice3

Third question choice for bubblesheet

qmChoice4

Forth question choice for bubblesheet

qmChoice5

Fifth question choice for bubblesheet
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Printing assessments for manual scoring
Assessments can be printed in Word or HTML form for participants to take on paper rather than online.
However, assessments delivered in this way must be scored manually. A more sophisticated means of
delivering assessments on paper is to use Questionmark's Printing and Scanning solution. Refer to See
"Printing and Scanning" on page 76 for more information.
This section contains information on how to:


Print assessments to Word



Print assessments to HTML

Printing assessments to Word
To print an assessment to Word:
1.

Open Authoring Manager and connect to your repository

2.

Highlight the assessment you want to print and from the Assessments menu, select Print
> Print Assessment to Word
The Print Assessment in Word Format screen is displayed
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3.

4.

Select the type of paper you wish to print:


Question - contains the questions in an assessment, usually formatted for answering on
paper



Answer - contains the correct answers to the questions in an assessment



Archive - the same as an answer paper, except that it always excludes any questions in the
assessment that have any rich media question types

If you are printing a question or answer paper, you can tick Avoid rich media question types?
to exclude the following question types: Captivate, Flash, Drag and Drop, and Hotspot. This option
is always applied if you are printing an archive paper.
It is not strictly necessary to avoid printing rich media questions, but as they are dynamic in
nature, they may not print well. Note: File Upload questions cannot be printed onto paper.

5.

Specify how to present introductions by selecting a Block Introductions option:


Display all - display introductory text for all question blocks in the printed assessment



Display first only - display introductory text for only the first question block in the printed
assessment



Display none - do not display introductory text in the printed assessment

6.

Specify Choice Numbering and Option numbering styles by selecting styles from the dropdown boxes

7.

In Master document, select the template you require. For more details on the master document
templates provided with Perception, please refer to Choosing a master document in See "Printing
and Scanning" on page 76

8.

If the assessment has been set to shuffle questions, you can define a randomization pattern by
entering an alphanumeric string of one to four characters in the Randomization key box. This
gives you the option of re-entering the same string in future and the printed assessment will be
identical.
If the assessment has NOT been set to shuffle questions, or you do not wish to define a
randomization key, leave this box blank

9.
10.

To save the options you have specified, so that they will be shown the next time you open this
screen, check the Save printing options box
Click Print
The assessment will be created and displayed in Word

Printing assessments to HTML
To print an assessment to HTML:
1.

Open Authoring Manager and connect to your repository

2.

Highlight the assessment you want to print and from the Assessments menu, select Print
> Print Assessment to HTML
The Print Assessment in HTML Format screen is displayed
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3.

4.

In the Output screen, specify where you want the HTML file to be created:


Display in browser - open the assessment in your default browser



Open in editor - create the HTML file on disk, and open the output file with a editor or word
processor



Print to file - use a file specified with the print files screen to contain the file



Direct to printer - send the questions or answers directly to the printer

If the assessment has been set to shuffle questions, you can define a randomization pattern by
entering an alphanumeric string of one to four characters in the Randomization key box. This
gives you the option of re-entering the same string in future and the printed assessment will be
identical.
If the assessment has NOT been set to shuffle questions, or you do not wish to define a
randomization key, leave this box blank

5.

In the Layout screen, specify Question Numbering, Choice Numbering and Option
numbering styles by selecting styles from the drop-down boxes

6.

To specify how many questions to fit on each page, tick Set Number Of Questions Per Page. If
you tick this, enter a number between 1 and 10 in the adjacent box or select it with the spin
control. This starts a new page after the specified number of questions, but will not shrink
questions to fit the page

7.

To display each question block separately, tick Show Question Blocks Separately
If ticked, a header is printed for each question block and the questions are numbered starting at 1
for the first question in each question block. If left unticked, no question block headers are shown
and the questions are numbered from 1 to the maximum number in the assessment.

8.

To include in the scoring information assessment outcomes with a score of zero, or without a
score defined, tick Show Outcomes With Zero Score

9.

In the Files screen, define the files that will be used in the printing process
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The Format File To Use For Printing is typically the master.format file installed in the
\perception5\authoring\format directory. Advanced users can modify this file, or make their
own template files to modify it
The Template File To Use For Printing is typically the default.template file installed in the
\perception5\authoring\default\system\template directory
10.

To save the options you have specified, so that they will be shown the next time you open this
screen, check the Save printing options box

11.

Click Print
The assessment will be created

Templates
Templates determine how screens in Perception are presented to participants. Templates can be modified
to control the functionality as well as the appearance of these screens. For example, you may wish to:


Replace the English text presented to participants when they log in to Perception and take an
assessment with the text of another language



Display your company logo and corporate style



Make your assessments more accessible to participants with disabilities

Templates are XML files with the extension .xtmp. Template files are stored in the \[repository]\templates
folder within each repository, where [repository] is the name of your repository. Numerous template files
are supplied with Perception. These are appropriate for delivering a wide range of assessments and can
meet the needs of most organizations. However, if none of the templates supplied with Perception
exactly match the way you want a particular assessment to be presented, you can create new templates.
When creating or editing assessments, authors can specify the template the assessment should use. In
Authoring Manager, this can be performed with the Assessment Wizard or the Assessment Editor.

There are two types of template - those that use Question by Question delivery, in other words, that
present each question individually, and those that do not.

Customizing templates
Templates can be modified to control the functionality as well as the appearance of screens. For example,
you may wish to:
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Customize the way an assessment is displayed so that it conforms precisely to your requirements



Display assessments with a company logo on the screen and generally conform to a corporate
style



Replace the English text presented to participants when they take an assessment with the text of
another language



Make your assessments more accessible to participants with disabilities

For more information on using templates to present assessments, please refer to the Templates
Reference Guide. This guide contains comprehensive guidance on how to modify and create template
files that can be used to present assessments that fully conform to your requirements.
The Templates Reference Guide is available to members of Questionmark Communities and is located on
the Perception Product Support site:
www.questionmark.com/perception/help/v5/product_guides/

Enabling participants to view reports
Links to a Coaching Report for an assessment that has just been taken can be displayed at the end of an
assessment. This can be useful if you want to show participants additional information on their
performance.
By default, links to Coaching Reports for assessments that have just been taken are not displayed at the
end of assessments. To display the link, authors must specify in the assessment outcome that the
assessment is to branch to a program or URL, and set the URL to branch to as %SESSION.REPORT%.
You can modify assessment outcomes in Authoring Manager or Browser-Based Authoring. To do so in
Authoring Manager:
1.

Open Authoring Manager

2.

Right-click the assessment you want to add a link to the Coaching Report to and click Edit
Assessment...

3.

Under Assessment, click Add Assessment Outcome

4.

Under Settings, click Outcome

5.

Check Branch to another program or URL and enter %SESSION.REPORT%

6.

Click OK
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Browser-Based Authoring
Browser-Based Authoring is a web application that enables authors to create questions and assessments
without needing to install Authoring Manager. If an author has been given permission to use BrowserBased Authoring, only an Internet connection and a web browser is required.
This chapter describes how authors can use Browser-Based Authoring, and is divided into:
See "Browser-Based Authoring" on page 16

See "Accessing Browser-Based Authoring" on page 89

See "Question Manager" on page 90

See "Assessment Manager" on page 95

See "Resource Manager" on page 99

See "Translation Manager" on page 100

See "Importing QPacks" on page 134

Accessing Browser-Based Authoring
Browser-Based Authoring can be accessed by logging-in to Enterprise Manager.
Enterprise Manager a web application that enables Perception administrators to manage the Perception
Server deployment. To access Enterprise Manager, enter the following URL into your browser:
http://<domain name>/em5/login.aspx
Where <domain name> is the name of the Perception Server domain. A typical URL might be:
http://www.questionmark.com/em5/login.aspx
Users of the On Demand service can access Enterprise Manager from a URL similar to:
https://ondemand.questionmark.com/<customerid>
Where <customerid> is the unique ID that relates to your On Demand service.
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Enter your User Name and Password, choose the appropriate language you would like Enterprise
Manager to use, and click Login.
To view the main Browser-Based Authoring screen, authors can select Authoring.
A typical author has access to some or all of the following elements.

If an author has been given permission to access other areas of Enterprise Manager, such as System
Administration or Enterprise Reporter, the author will be able to navigate to these Enterprise Manager
and see the available areas using the available menus.

Question Manager
When Question Manager is started, all topics the author has access to are displayed.
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From here, authors can select an option in the Topic Options menu to:


Create a root topic



Create a subtopic



Delete a root topic or subtopic




Set security permissions on root topics
Import questions from a QPack (refer to See "Importing QPacks" on page 134 for more
information)

To work with questions in a specific topic, highlight the topic and select Open topic in the Topic Options
menu.

Working with questions
When a author opens a topic, the questions in the topic are displayed.

From here, authors can select an option in the Question Options menu to:


Create a new question



Try out a question
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Edit a question



Delete a question

Creating questions
To create a question, select New Question from the Question Options menu. This opens the Question
Wizard.

Authors can create the following types of question:


Multiple Choice



Yes/No



True/False



Likert scale



Numeric



Multiple Response



Text Match Essay

To create a question, select the type of question you want to create and click Create. Then complete
each step of the Question Wizard to create your question.
Not every question type that can be included in Perception assessments can be created with
Question Manager. To create every type of question, use Authoring Manager.
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Editing questions
To edit a question, highlight the question and select Edit from the Question Options menu. This opens
the Question Editor.

Use the << Back and Next >> buttons to navigate through each page of the Question Editor, and click
Finish to apply your changes to the question.
Not all types of question can be edited in Question Manager. To determine if a question can be edited
with Question Manager, look at the icon associated with the question.
This icon is displayed next to questions when it is not possible to edit them with Question Manager
This icon is displayed next to questions that can be edited with Question Manager
The following screenshot shows two questions that can be edited with Question Manager.
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For details of when questions can be edited in Question Manager, please refer to See "Editing questions
created in Authoring Manager" on page 132.

Setting security permissions
An author's access to root topics can be controlled from within Question Manager. For example, you may
want to restrict one author from being able to edit the questions in a topic, while you may want to give
another author the ability to edit and delete questions in the same topic.
It is not possible to set security permissions on subtopics. To set the security permissions for a root topic:
1.

Open Question Manager

2.

Highlight the root topic you want to set security permissions for and select Set security
permissions from the Question Options menu. This opens the Security Permissions Editor

3.

Set the View, Edit and Full permissions for each author

4.
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View - the selected authors can only view, tryout or copy the root topic and any subtopics
below it



Edit - the selected authors can do everything with the selected root topic and any subtopics
below it, except delete the root topic, delete a subtopic below the root topic, delete a
question in the root topic or in a subtopic below the root topic, or cut any of the above



Full - the selected administrators can do everything with the selected root topic and any
subtopics below it

Click Finish to set the security permissions

Assessment Manager
When Assessment Manager is started, all assessment folders the author has access to are displayed.

From here, authors can:


Set security permissions for a particular assessment folder



Open a particular assessment folder



Import a QPack (refer to See "Importing QPacks" on page 134 for more information)

To set security permissions or open an assessment folder, highlight the assessment folder and select the
appropriate option in the Assessment Options menu.
You cannot create or modify assessment folders in Assessment Manager. To do so, use Authoring
Manager.

Working with assessments
When an author opens an assessment folder, the assessments in the folder are displayed.

From here, authors can select an option in the Assessment Options menu to:


Create a new assessment



Try out an assessment



Edit an assessment



Delete an assessment



Publish the assessment to LMS
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Set scheduling permissions

Creating assessments
To create an assessment, select New Assessment from the Assessment Options menu. This opens
the Assessment Wizard.

Authors can create the following types of assessment:


Quiz



Test



Survey



Exam



Unset (non-specific assessment)

Refer to See "Assessment types" on page 61 for more information on each type of assessment.
To create an assessment, enter the required information on each screen of the Assessment Wizard. Use
the << Back and Next >> buttons to navigate through each screen, and click Finish to create the
assessment.
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Editing assessments
To edit an assessment, highlight the assessment and select Edit from the Assessment Options menu.
This opens the Assessment Editor.
Assessments made with Authoring Manager can be edited in Enterprise Manager if:


They have only one question block, and either one or two score bands



They don't have jumps



They don't use references to special fields in the question selection



Certain other advanced functionality is not used

Setting security permissions
It is possible to set security permissions for the following parts of an assessment:


Access to assessment folders



Access to scheduling an assessment

These are described below.

Controlling access to assessment folders
An author's access to assessment folders can be controlled from within Assessment Manager. For
example, you may want to restrict one author from being able to edit the assessments in an assessment
folder, while you may want to give another author the ability to edit and delete assessments in the same
folder.
Security permissions can only be set on root assessment folders. To set the security permissions for an
assessment folder:
1.

Open Assessment Manager

2.

Highlight the assessment folder you want to set security permissions for and select Set security
permissions from the Assessment Options menu. This opens the Security Permissions Editor
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3.

4.

Set the View, Edit and Full permissions for each author


View - the selected authors can only view, tryout or copy the assessment folder and any
folders below it



Edit - the selected authors can do everything with the assessment folder and any folders
below it, except delete the root folder, delete a sub-folder within the root folder, delete an
assessment in the root folder or sub-folder, or cut any of the above



Full - the selected administrators can do everything with the selected assessment folder
and any sub-folders below it

Click Finish to set the security permissions

Controlling access to scheduling assessments
The ability of an author to schedule an assessment can be controlled from within Assessment Manager.
For example, you may want to restrict one author from being able to schedule a particular assessment,
while you may want to give another author the ability to schedule the assessment.
Access to scheduling assessments is controlled on a group basis. In this way, you can specify that all
authors belonging to a particular group can be given scheduling rights for particular assessments. To set
the scheduling permissions for an assessment:
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1.

Open Assessment Manager

2.

Highlight the assessment folder containing the assessment you want to control scheduling rights
for, and select Open Assessment Folder from the Assessment Options menu

3.

Highlight the assessment you want to control scheduling rights for, and select Set Scheduling
Permissions from the Assessment Options menu. This opens the Scheduling Permissions
Editor

4.

Add the groups you want to assign scheduling rights for to the Groups assigned column.

5.

Click Finish to set the security permissions

Resource Manager
When Resource Manager is started, the resources that the author has access to are displayed.

Resources can be:
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Topic Resources - Associated with individual topics



Global Resources - Associated with all topics

To work with resources in a Topic Resources folder or Global Resources folder, highlight the folder and
select Open Folder in the Resource Options menu.
When an author opens a resources folder, the resources in the folder are displayed.

From here, authors can select an option in the Resource Options menu to:


Upload a resource



Replace a resource



Remove a resource

Translation Manager
Translation Manager is part of Browser-Based Authoring and allows authors to create translations based
on topics or assessments. Once a set of translations has been made, participants will then be able to pick
a language of their choice to take the assessment in.
Translation Manager allows authors to create translation directly in Enterprise Manager, or export the
language content out as XLIFF. XLIFF is an XML-based format that enables translators to concentrate on
the text to be translated, rather than have to worry about medium the text is available in or the format of
it.
For further information about Browser-Based Translation Manager, please refer to:


How does Translation Manager work?



What is XLIFF?



Using Translation Manager



Working with translation projects



Translating content via Perception



Status flow diagram



Consideration to be taken when using Translation Manager



Working with translated items in Qpacks

How does Translation Manager work?
Translation Manager is designed to make the process of translating content into multiple languages easy.
It works by taking a root item and confirming this object as the baseline for the translations. The
translation, using the root item as the definitive guide, can then be translated and stored as shown in the
diagram below.
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The following section describes:


The translation workflow



Maintaining translated items



Branching translations to create unique items

Translation workflow
Translations are created for 3 different items in Perception. These are


Topics



Questions



Assessments

This means that to translate an assessment you will first need to translate a topic and then the questions.
This ensures that once the items have been fully translated all the constituent parts of the assessment is
then available to be scheduled.
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Translation maintenance
Perception is designed to notify users if an item that has been translated is changed. Meaning if an
author changes the Root item in the base language this is notified to any translators that may use
Translation Manager. This ensures that translated content is always kept up to-date with the original
item.
Items being translated are usually grouped into projects. For example, translating a topic of questions is
seen as project. Additionally, translating an assessment is also a project. Translation are grouped into
projects to make them easier to manage. Translation project can be assigned different statuses to keep
other users and translators informed of the progress of the project. For further details about the statuses
that can be manually applied or applied automatically by Translation Manager, please refer to the section
Status flow diagram. Once a translation of an assessment in complete it will need to be approved before
it is available for scheduling.

Branching translations
Due to the nature of translations a question or group of questions may need to change significantly when
compared to the original. If this occurs it may be desirable to create future translations of the modified
question rather than the original. For example, if you create a question that is region specific or language
specific the translated question now no longer becomes merely a translation of the same text but a rewording of the entire question. Translation Manager allows a topic that has translated questions within it
to be copied to a separate topic and the chosen translated language to become the base language for the
topic and questions copied.
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For further details about how to Copy as base a specific topic, please refer to Using Translation Manager.

Providing the participant with language options
Translation Manager allows the same assessment to be translated in to many languages. Perception can
then be used to:


Define which language is delivered to a participant



Allow the participant to choose a language of their choice, as shown below
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These options are available when scheduling an assessment for delivery in Assessment Manager.

What is XLIFF?
XLIFF is an XML-based format that allows translators to easily translate content without having to worry
about the format. In its most basic form, XLIFF consists of one or more translation elements. Each
element is required to be translated into the given language. The XLIFF file also contains information
relating to Perception, this is stored in the header of the file while the general text to be translated is
stored in the body section. Each element that needs to be translated in stored as trans-unit elements
within the body section of the file. For example, a Perception XLIFF file may contain some of the
following trans-elements:


Question title



Question description



Question stimulus



Question choices



Question outcomes



Question feedback



Assessment title



Assessment description



Assessment feedback



Assessment outcomes

These trans-elements often include the original text known as the Source language, but also duplicate
trans-elements that contains the text that can be translated (Target language). Perception can be
configured to include the target language trans-elements or not, this depends on the preferred method of
translating. The benefit of XLIFF is using 3rd party applications like Trados that allows translators to do a
comparative translation without needing to worry about formatting and layout. The text below is an
example of the layout of an XLIFF file.
<trans-unit id="Q9630183719559230Description" restype="x-questionmark-QuestionDescription"
datatype="plaintext" size-unit="char" maxwidth="200">
<source>This is a sentence.</source>
<target xml:lang="fr">Translation of "This is a sentence."</target>
</trans-unit>
<trans-unit id="Q9630183719559230Wording" restype="x-questionmark-QuestionWording"
datatype="html">
<source>This is a sentence.</source>
<target xml:lang="fr">Translation of "This is a sentence."</target>
</trans-unit>
As you can see the translator can compare the translated text directly with the source language while
translating. For instructions about how to complete the translation of an XLIFF file using a 3rd party tool,
please refer to the documentation that accompanied it.
The same approach of comparative translation is also adopted for the translation done via Perception in
the Browser-Based Translation Manager, as shown below:
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Why was XLIFF chosen as the translation format of choice?
XLIFF was chosen as the translation format of choice by Questionmark because it provides a flexible
approach to translations and is the most commonly used format by localization/translation vendors as it is
an industry standard format that provides a self contained translation method. This is beneficial because:


There is less dependency on vendors, as now most vendors already use XLIFF when translating
content



XLIFF is easier to handle as it is a standards based file format with multiple tools capable of editing
the file correctly



XLIFF can be generated on a per-project basis, allowing greater control of the information
provided to translation vendors



XLIFF can be used to control the information flow because it can include details about the data
included in the XLIFF file
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The original format release (version 1.0) of XLIFF was made available in April 2002. The current
XLIFF file format is version 1.2 (released February 2008). Perception is compatible with generating and
importing XLIFF files that comply with the XLIFF 1.2 standard. If you are using translations tools you
should ensure that they are compatible with the relevant XLIFF version.

Using Translation Manager
Translation Manager is a built-in application designed to allow organizations to easily translate questions
and assessments into various languages. Translation Manager uses projects to identify what is going to
be translated in to other languages.
Projects can be created to either:


Translate everything in a topic



Translate an assessment

Translations can be done in Perception, or a 3rd party application capable of editing eXtensible Markup
Language files in the XLIFF file format. XLIFF is a standard used to describe data stored in a file through
the use of tags. To find out more about XLIFF, please refer to:


See "What is XLIFF?" on page 104

To find out how to use Translation Manager, please refer to the following section:


Projects tab



Updates tab



Repository tab

Projects tab
The Projects tab allows a user to manage translation projects in Perception. Using this tab a user can:


Create a new project



Import XML relating to a project



View the project in the repository



Discard the project



Approve the project

This tab is the first of three that is available in Translation Manager. To find out more about what can be
accomplished on the other tabs, please refer to the links below:


Updates tab



Repositories tab

The Projects tab displays any existing translation projects in a table as shown below.

106

The table contains information about the projects stored in the repository and includes the following
detailed below.
Title

Description

Project Name

The title of the project

Type

Whether the project is to translate a whole topic or an assessment

Date Created

The date the topic was created

Date Last
Modified

The date the project was last updated or modified

Owner

Who created the project

Source

The language the original content is in

Target

The language the translated content is in

Status

The status of the translation. This can be:


In Perception translation - Awaiting to be translated using Perception



XML Exported - The XML needing to be translated has been exported



XML Imported - The XML containing the translated contents has been imported
back in to Perception



Approved - The translations included in the project have been completed and
approved. The contents are ready to be used

For further details about the statuses used by Translation Manager, please refer to the
translation project section of Status flow diagram.
The description of a Translation project is displayed when the mouse pointer is moved over the project
name. Existing translation projects can be searched for using the filters available.
Creating a project
For details about hot to use the Translation project wizard to create Translation projects for assessments
and topics, please refer to the section:


See "Working with translation projects" on page 115

Importing an XML file to a project
An XML file can only be imported to a project that originally had its XML exported for translation. To
import an XML file it must be imported in to the same project from which it was exported, otherwise an
error will occur. To import an XML file:
1.

Select the project that the original XML file was exported from

2.

Click Import XML from the Options menu

3.

Browse to the location of the XML file on your computer or network and click Open

4.

Click Import
If the import is successful you will be informed, if the import is unsuccessful an error will be
displayed describing possible causes and solutions to this error.
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Viewing a project in a repository
Viewing a project in the repository displays the Repository tab with the filters already applied so that
only the details and translations relating to the project selected appear in the repository view. The
repository view will contain the topics and sub-topics of the project and the information in them can be
viewed by selecting the topic.
To view the contents of a project as it appears in the repository:
1.

Select a project from the list of available projects

2.

Click View in repository from the Options menu

It is only possible to view one project at a time in the repository.
For further details, please refer to the section Repository tab.
Discarding a project
Projects can only be discarded if they have not been approved. To discard a project that has not been
approved:
1.

Select the project from the list of available projects

2.

Click Discard from the Options menu

Only one project at a time can be discarded.
Once a project has been discarded it is not possible to retrieve any information from this project
or reinstate it.
Approving a project
A project can be approved once all the translations required for the project are completed. For example,
a translator completes a translation of an assessment and has it reviewed. Now to make the translated
assessment available for participants it needs to be approved, this is another way of saying that the
translation project is complete.
A project can only be approved when the project status is:


XML Imported



In perception translation

To approve a project:
1.

Select the project from the list

2.

Click Approve from the Options menu

3.

Click OK on the Are your sure you want to approve the selected project? warning message

Searching for a project
To search for a project a user can apply filters. Filters determine what should be shown. For example, a
filter can be applied to show only the projects that contain the word "translation" in the project name.
Filters that can be applied are:


Project Name



Language used in the project (either the Source or the Target language)
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Statuses of the project

To apply a filter:
1.

Select the type of filter to apply to the keywords. Project names can be filtered by applying the
following to the keywords:


Contains



Equals



Begins with



Ends with

2.

Enter the keyword to search for in the text-box

3.

Select the language to filter the projects by

4.

Select the status for the projects to be displayed

5.

Click Search

The screen will update to only show the projects that meet the criteria set out in the filters.

Updates tab
The Updates tab displays a table containing any assessments or topic and question translations that have
the status Needs updating.
The table below describes the information for each update.
Heading
Name

Description
The name of the item that needs updating. It will be either the:

Type



Question description



Assessment name



Topic name

The type of the content that needs updating. The possible value are:


Question



Assessment



Topic

Modified

The date the content was last modified. This will only be displayed for an assessment or
question.

Source

The source or base language of the assessment, topic or question

Target

The language that the assessment, topic or question is being translated into

For the listed updates it is possible to:


Open in repository
This will open the Repository tab displaying the contents of the repository in relation to the
required update



Edit translation
This will open the Edit Translation window where the required update can be completed and saved

109

Opening an update in the repository view
To open an update in a repository view:
1.

Select the appropriate update from the table

2.

Click Open in repository from the Options menu

Editing a translation
To edit the translation directly from the Updates tab:
1.

Select the appropriate update from the table

2.

Click Edit translation from the Options menu

An Edit translation window is displayed where any updates can be made and saved.

Repository tab
The repository view displays the translation information as it appears in the repository. The Repository
tab can be used to:


Set a base language



Add a translation



Edit a translation



Delete a translation



Tryout a translation



Copy a translation as a base



Manually set the translation status

The screen is divided into four parts as indicated in the image below.

Each of the parts identified are described in the table below.
Part
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Name

Description

Part
1

Name
Filters

Description
This section of the screen displays the filters applied to the repository to display the
current Repository structure. By default the filters applied will relate to the project
selected. For example, to apply a filter to only show the repository content relating
to a specific project:
1.

Select the project from the Projects tab

2.

Click View in repository from the Options menu

The screen will be updated to show the Repository tab with the filters applied to
only show the relevant project. The filter can be removed by clicking Remove the
Filter?.
If the Repository view does not already have filters applied it is also possible to filter
the content of the repositories by language. To apply a language filter:
1.

Select a specific language from the languages drop-down list

2.

Click Search

The Content view will only display content that forms part of a project where the
language specified was used.
2

Repository
structure

The repository structure window displays the topic and assessment folders and subfolders. If filters are applied the folder views will be limited by the filters. To open
folders to view the content:
Click '+'
Or
Double-click the folder name

3

4

Content view

Preview

The content view displays the content relating to the question, assessment or topic
folder. It will only become visible as assessments or questions are selected. It shows
each language the content has been translated into and provides links to:


Add Translation - Add further language translations to the selected content



Edit Translation - Edit a selected translation to make amendments. For
further details about how to edit translation text, please refer to Translating
contents



Delete Translation - Delete the selected translation because it is no longer
required



Try Out - View the selected contents in the Preview window



Copy as base - Creates a copy of a selected item with the chosen language
as the base language

The preview window is available when an assessment or question is chosen from a
translation project. It allows authors to view the content as it would appear to a
participant.
The preview window can be hidden if required. To hide the preview window click
Hide preview. To show a hidden preview window click Show Preview.
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Setting a base language
In the repository view if you select a topic that has not had a base language (source language) defined
for it the Set Base Language option will be displayed on the right of the screen. The topic name is
displayed along with a <Select Language> drop-down list. To set a base language for a topic:
1.

Click
Or
If the language has been used previously in the repository select it from the <Select Language>
drop-down list and move to step 4.

2.

Select a language to set as the base language from the list

3.

Click OK

4.

Click Set Base Language

The base language has now been set for this topic and its sub-topics.

Adding a translation
It is possible to add a translation for a Question, Topic or Assessment to the repository. To add a
translation:
1.

Select the item to add a translation for

2.

Click Add Translation

3.

Select the language to add a translation for
If you are translating an assessment it is only possible to choose a language where the questions
have already been translated into the chosen language. For example, it is not possible to translate
an assessment into Spanish if the questions have only been translated into French. To translate as
assessment in to Spanish you will first need to translate the questions.

4.

Click OK
The Edit Translation page opens.

Editing a translation
It is possible to edit a translation that already exists for a Question, Topic or Assessment in the
repository. To edit a translation:
1.

Locate and select an item to edit the translation of

2.

Click Edit Translation
The Edit Translation page opens

Deleting a translation
It is possible to delete a translation of a Question, Topic or Assessment from the repository. To delete a
translation:
1.

Locate and select the content whose translation you want to delete

2.

Click Delete Translation
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Trying out a translated question
Try Out allows administrators to preview and try the content as it would appear to participants. Only
questions and assessments can be tried out. To try out an item:
1.

Navigate to the item in the repository view on the left

2.

Select the item

3.

Select the item you would like to try out
This can either be the base item or one of the translated items

4.

Click Try Out
A window opens with a preview of the item

It is possible to Try out several translations of a question at once. This can be used to compare the
various versions of the translation. To compare translation:
1.

Navigate to the item in the repository view

2.

Select several translation you would like to compare (you can do this by holding down the Ctrl
button and selecting the required items)

3.

Click Try Out

Several windows open with a preview of the items. It is only possible to open 3 items at a time.

Copying a translation as a base
In certain circumstances it may be necessary to alter a question when translating. For example, if
questions are region specific it may be necessary to change the question significantly from the original.
The changes could cause confusion when updating the questions in the future because they no longer
match the base language. To combat this it is possible to branch a topic and set a new base language for
the topic.
The Copy as base option allows translators to copy a translated topic and all its questions (including sub
topic) as base items. So that user can create assessment including translated items and schedule
participants to take assessment using Enterprise Manager. However, it is important to understand that
only questions in a topic with a translation status of Translated are copied to the new topic
To Copy as base a topic:
1.

Select a topic from the repository view

2.

Choose a translated topic

3.

Click Copy as base and enter a new name for the topic

4.

Click Copy

The new topic is displayed in the repository along with any questions that were marked as Translated.
These questions can now be translated into further languages in the same way that the original
translations were done. Changes made to the question that will not affect the original question and topic
from where the items were copied.
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Setting the translation status
The translation status of an item allows users to identify at what stage the item is when going through
the translation process. The status is updated automatically after a certain step is completed. The
statuses that can be applied are listed below.
Status

Description

Awaiting translation

The item needs to be translated

Awaiting approval

The item has been translated but now needs approval

Awaiting re-translation

The item has not been approved and needs to be re-translated

Awaiting approval or retranslation

The item translation has been corrected and it needs approval again

Translated

The translation has been approved

Needs update

The source content has been updated and the translated version still
needs to be updated

The status of an item is automatically set after certain stages. However, the statuses set can be manually
set as well.
To manually set the status of an item:
1.

Click on the status in the Translation Status column

The status will change into a drop-down box
2.

Select the appropriate status from the list

The selected status is now applied to the item
For further information about the statuses that can be applied to a translated item and the work flow that
causes item statuses to change, please refer to the section:
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See "Status flow diagram" on page 124

Working with translation projects
Translation Manager allows users to create projects to group translations together. For example, a
project can be created to translate all the contents within a topic or for an assessment. This makes the
management and tracking of translation easier.
Projects are created on a per item type basis. This means that a project to translate an assessment can
not be done until a project to translate the questions has been completed. For example, creating a
translation project for an assessment that has not had the questions translated will result in the
assessment translation project being aborted and warning messages displayed to the user. For further
details about how Translation Manager works, please refer to the section:


How does Translation Manager work?

Creating a project
To create a translation project from the Translation Manager page:
1.

Select New Project from the Options menu

2.

Select what type of content will be translated in this project, The option available are:


Translation of all the questions in a topic



Translation of all text in an assessment

To choose the type of content to translate select Translate topic or Translate assessment
3.
4.

Click Next >> to continue
Apply the appropriate settings to the translation project as shown below.

Applying settings to a translation project
The following settings can be applied to the translation project:
1.

Enter a name for the project in the Project name text-box
This will make is easy to identify when you have multiple projects

2.

Enter a description of the project in the Description text-box
The description can be used to identify what the project contains

3.

Click

and select the Source language from the list that appears and click OK

Or
If content within the repository has previously been translated the languages chosen will appear in
the drop-down list. A Source language can be chosen from this drop-down list if it is the same
for this project
4.

Click

and select the Target language from the list that appears and click OK

Or
If content within the repository has previously been translated the languages chosen will appear in
the drop-down list. A Target language can be chosen from this drop-down list if it is the same
for this project
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5.

6.

7.

Select the Translation method you would like do the translation in. The translation can be done:


within Perception - This will allow the translation to be completed in Browser-Based
Authoring



via XML - This will generate an XLIFF file that can be translated using any 3rd Party
application capable of editing XLIFF files

Select the Text to include in the translation project. The included text can be:


All text - This allows the user to translate all the text in the chosen topic or assessment



Only text that is not yet translated - This allows the user to translate only the text in
the topic or assessment that has not already had its translation approved

Click Next>> to continue. The next page displayed will depend if the project was intended to
translate an assessment or a topic

Selecting a topic to translate
To choose the relevant topic to include in your translation project:
1.

Click '+' on the Topics folder to reveal the topics that are available

2.

Locate and select the required topic to translate and click Next >> to continue
If the Translation method chosen, was:


within Perception
It is possible to define if the sub-topics of a parent topic will also be included in the
translation project by placing a check-mark in the Include sub-topics check-box



via XML
It is possible to define:


If the Translation project includes the topic names and descriptions by placing a tick
in the Translate topic name and descriptions check-box



If the sub-topics of a parent topic will also be included in the translation project by
placing a tick in the Include sub-topics check-box



If the topic outcomes are also included in the translation project by placing a tick in
the Include topic outcomes check-box

When translating a topic within Perception, by default, you will also need to translate
the topic:


Name and descriptions



Outcomes

Additionally, when a topic is selected that does not have a base language assigned a
prompt will be displayed requiring asking the user to click Yes to set the base language
for the topic to the same as the Source language for the project, or Cancel to leave
the topic without a base language defined
3.

The translation project is created. If any errors have occurred these will be displayed, for further
details about possible errors, please refer to the section Considerations when using Translation
Manager

4.

If you created a project:
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within Perception - Click Finish to be taken to the Repository tab to create some
translations, refer to the section Working with translation projects



via XML - Save the XLIFF file to your computer and click Finish to return to the Project tab

Selecting an assessment to translate
To choose the relevant assessment to include in your translation project:
1.

Click '+' the Assessments folder to reveal assessment folders that are available

2.

Double-click the assessment folder name

3.

Locate and select the required assessment to translate and click Next >> to continue

4.

The translation project is created. If any errors have occurred these will be displayed, for further
details about possible errors, please refer to the section Considerations when using Translation
Manager

5.

If you created a project:


within Perception - Click Finish to be taken to the Repository tab to create some
translations, refer to the section Working with translation projects



via XML - Save the XLIFF file to your computer and click Finish to return to the Project tab

Translating contents
When updating the contents of a translation project an author will need to translate the text stored in the
repository. For any translation project assigned to be done within Perception this means that the Edit
Translation window will be needed. There are three types of Edit Translation window available.
If you are editing a question or assessment the author may have left some guidance on what information
has changed. This information is displayed on the Edit Translation window to assist with any further
translation required. For further details, refer to Using the guidance information when updating a
translation below.
When editing a translation for a question or assessment it is possible to format the translated language
using the editor available. For instructions about using the formatting features, refer to Formatting the
translated text below.

Editing a Translation
When editing a translation each Edit Translation window is slightly different in what it displays. But
they are all designed to do the same thing, show the original (Base) language on the left hand-side and
allow authors to type translations on the right hand side.
To edit a translation using the Edit Translation window select the type of item you want to translate from
the list below.


Topic translation



Question translation



Assessment translation

Topic translations
The Edit Translation window allows authors to create translations of topics in the Perception repository.
The Edit Translation window shows the Topic Name and Topic Description in the Source language. It
allows authors to store the translated Topic Name and Topic Description in the repository by updating
the corresponding text on the right-hand side of the screen in to the Target language.
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To translate the Topic:
1.

Click the text-box that appears in the Topic Name section of the screen under Target

2.

Delete the contents and insert the translated topic name

3.

Click the text-box that appears in the Topic Description section of the screen under Target

4.

Delete the contents and insert the translated topic description

5.

Click Save
You will be returned to the Repository tab of the Browser-Based Translation Manager where the
status of the Topic Translation will be updated to Translated.

Question translation
The Edit Translation window allows authors to create or update translations of questions in the
Perception repository.
The Edit Translation window shows the details of the question in the Source language and allows authors
to update the text found in the corresponding Target language text boxes.
Only the text for the Target language can be modified. It is possible to modify the details using the
Design view to format the translated text or in HTML view.
The following information can be updated when translating a question (options available depend on the
type of question being translated):


Description



Stimulus



Choices



Choice Options



Feedback Conditions



Feedback

Question Description

A question description is often applied to a question to allow authors to describe the question that has
been created. For some questions the Question Stimulus may be split in to Fragments.
To translate a Question Description:
1.

Select the text-box relating to the Question Description under the Target language on the right
hand-side of the screen

2.

Delete the text

3.

Insert a translation

Question Stimulus
The Question Stimulus is the information that is provided to a participant which they must use to choose
or form the correct answer.
To translate the Question Stimulus:
1.
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Select the text-box relating to the Question Stimulus under Target language on the right handside of the screen

2.

Translate the Question Stimulus using the format tools or update the text using HTML code by
click the HTML tab

Question Choices

Question Choices represent the answers that a participant can choose.
To translate the Question Choices:
1.

Select the text-box relating to the Question Choices under Target language on the right handside of the screen

2.

Translate the Question Choices using the format tools or update the text using HTML code by click
the HTML tab

Question Choice Options

Question Choice Options are a list of the options available for each choice within a question.
To translate the Question Choices:
1.

Select the text-box relating to the Question Choices Options under Target language on the
right hand-side of the screen

2.

Translate the Question Choice Options using the format tools or update the text using HTML code
by click the HTML tab

Question Feedback Condition

Question Feedback Conditions are the conditions that accomplished before a certain type of feedback is
displayed. For example, at a basic level the feedback condition determine if a question is to respond with
the feedback of a correct or incorrect answer.
To translate a Question Feedback Condition:
1.

Select the text-box relating to the Question Feedback Condition under the Target language on
the right hand-side of the screen

2.

Delete the text

3.

Insert a translation

Question Feedback

Question Feedback is the information that is presented to a participant once they have submitted a
question.
To translate the Question Feedback:
1.

Select the text-box relating to the Question Feedback under Target language on the right handside of the screen

2.

Translate the Question Feedback using the format tools or update the text using HTML code by
click the HTML tab

Assessment translation
The Edit Translation window allows authors to create or update translations of assessments in the
Perception repository.
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The Edit Translation window shows the details of the assessments in the Source language and allows
authors to update the text found in the corresponding Target language text boxes.
Only the text for the Target language can be modified. This text can be reformatted with the various
design elements available in the formatting toolbar.
The following information can be updated when translating a question (options available depend on the
type of question being translated):


Assessment details



Question block



Outcomes



Topic Outcomes

Assessment details

The assessment details that can be translated include:


Assessment Name
To translate the assessment name select the corresponding target text-box and insert the
translated equivalent



Assessment Template
The template used to present the assessment can not be edited/translated but a new template can
be chosen. The new template may contain translated elements by design

Assessment Question Blocks

The Assessment Question Block section includes details that are displayed to a participant. For example,
introduction/instruction text displayed at the beginning of the question block.
To translate a Assessment Question Block:
1.

Select the text-box relating to the Assessment Question Block: Intro Text under the Target
language on the right hand-side of the screen

2.

Delete the text

3.

Translate the Intro Text using the text editor options to format the text or update the text using
HTML code by click the HTML tab

Assessment Outcomes

The Assessment Outcome section includes details about all the different outcomes available in the
assessment. For example, a typical assessment may include two outcomes, a pass and a fail outcome.
Each outcome has a corresponding name and message.
To translate the Assessment Outcome:
1.

Select the text-box relating to the Assessment Outcome Name under Target language on the
right hand-side of the screen

2.

Translate the Question Stimulus using the text editor options to format the text or update the text
using HTML code by click the HTML tab

3.

Select the text-box relating to the Assessment Outcome Message under Target language on
the right hand-side of the screen

4.

Translate the Question Stimulus using the text editor options to format the text or update the text
using HTML code by click the HTML tab
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5.

Repeat the process for all the available assessment outcomes

Assessment Topic Outcomes

Question Choices represent the answers that a participant can choose.
To translate the Question Choices:
1.

Select the text-box relating to the Question Choices under Target language on the right handside of the screen

2.

Translate the Question Stimulus using the text editor options to format the text or update the text
using HTML code by click the HTML tab

Using the guidance information when updating a translation
Guidance is displayed for the translating author in a yellow text-box that appears at the top of the
screen. The Guidance text-box displays information regarding:


The number of Revisions made



Who Modified the question



On what date they were modified



Comments added by the person who modified the question

This allows authors updating the translation of the question to understand what updates have been
made. This is especially important when updating long or complicated questions to ensure all added
information is translated.

Formatting the translated text
Perception can be used to format the text used in the translation to the target language. It allows users
to underline, emphasize, change color, add lists to any translated text.
The following table describes the options available on the text editor toolbars for text entry.
Icon

Description
To insert Bold text, click the icon and enter the required text. To change text
already entered to bold, highlight the text required and click the icon. Click the icon
again to return to normal text.
To insert Italic text, click the icon and enter the required text. To change text
already entered to italic, highlight the text required and click the icon. Click the icon
again to return to normal text.
To insert Underlined text, click the icon and enter the required text. To change text
already entered to include an underline, highlight the text required and click the
icon. Click the icon again to return to normal text.
To insert Strike-through text, click the icon and enter the required text. To change
text already entered to include a strike-through, highlight the text required and
click the icon.
To insert subscript or superscript text, click the required icon and enter the required text. To
change text already entered to be either subscript or superscript, highlight the text
and click the icon. Click the icon again to return to normal text.
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Icon

Description
To justify the text in a paragraph to either the left hand-side, right hand-side,
center or aligned to fill the whole line, select the paragraph and click the required
justified icon. The text can be justified per paragraph. So, one paragraph can be
justified to the center, while another paragraph can be justified to the left handside.
A paragraph can be indented by placing the cursor anywhere in the paragraph and
clicking the Increase indent icon. It is also possible to decrease the indentation
of an indented paragraph by placing the cursor anywhere in the paragraph and
clicking the Decrease indent icon.
It is possible to create ordered (numbered) or unordered (bulleted) lists.
To create a list:
1.

Click the list icon for either a bulleted or numbered list

2.

Insert some text to appear as the first entry in a list

3.

Press the Enter/Return key to create a new item for the list

4.

Enter some more text

5.

Repeat steps 3 and 4 until the list is complete

6.

To end the list click the list icon again

To change the color of the font:
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1.

Click the Font Color icon

2.

Select the shade of the colors you want to use

3.

Click on the required color

4.

Or, enter the hexadecimal value for the color in the text-box and press
Enter/Return

Icon

Description

To highlight text (change the background color):
1.

Place the cursor in the word to high-light a single word, or use the mouse
pointer to high-light a portion of the text

2.

Click the Font Highlight icon

3.

Select the shade of the colors you want to use

4.

Click on the required color

5.

Or, enter the hexadecimal value for the color in the text-box and press
Enter/Return

It is possible to insert links to other applications and web pages in the translated
text.
To insert a link:
1.

High-light the text you want to turn into a link

2.

Click the Insert link icon. The Hyperlink window will open

3.

Select the Type of link you want to create

4.

Update the URL text-box
Do not delete the link specifier from the URL text-box as this will affect
how the participant's computer will react when the link is clicked. For
example, the link specifier http:// will open a web page, while the mailto:
specifier will open an email addressed to the person specified in the URL
text-box using the default email application on the participants computer.
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Icon

Description
5.

Click OK

It is possible to find specific text and if required, replace it with an alternative.
To use the find and replace functionality:
1.

Click the Find icon
The Find/Replace window will open

2.

Enter the text to find in the Find what text-box

3.

It is possible to only find instance of the search term that Match case or
Match the whole word by placing a tick in the required check-box

4.

You can find the text by clicking Find Next

5.

Or, you can replace the found text with any text entered in the Replace
with text-box and clicking Replace. To replace all instances of the word
with the replaced text click Replace All.

6.

Click Cancel to close the window

Images can be added to the text.
To add an image:
1.

Click the Insert Image icon
The Modify image window is displayed. The window shows the Files stored
in the repository of your Perception installation.

2.

Locate the image to include
To add an image it must have been added as a resource and can be found
in the topicresources folder. You can view the contents of a folder by
clicking the folder name. To return to the previous folder click Browse Up.

3.

Selecting the image to include will provide a preview of the image in the
Preview box and the image details will be displayed

4.

Select where the image should appear on the screen by selecting its
alignment from the Align drop-down list

5.

Insert an alternative description of the image for browsers that do not
support images in the Alt text text-box

6.

Choose the thickness of the border from the Border drop-down list

7.

Click OK to add the image

Status flow diagram
The following section describes the available statuses in Translation Manager. Statuses are applied
differently for:


Translation items



Translation projects
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Statuses are applied to items and projects so that users can easily identify what translation work need to
be carried out. This section also identifies what actions will cause the different statuses to be applied to
an item or project.
Each item in a Translation project can have a different status. The status applied to the item is separate
to the status of the project.

Translation items
The available statuses in Translation Manager for items are included in the table below.
ID

Status

Description

1

Awaiting
translation

The item is part of a project. The target language did not exist previously.

2

Awaiting Approval The item is part of a project. The target language did not exist previously. The
user has updated the item, but has not approved the project yet.

3

Awaiting Retranslation

4

Awaiting Approval The item is part of a project. The target language did exist previously, and is
of re-translation
being edited. The user has updated the item, but has not approved the project
yet. If the user decides to discard the project this item will not be deleted.

5

Translated

Item has been translated

6

Needs update

Item needs update

The item is part of a project. The target language did exist previously, and is
being edited.

The following flow diagram highlights the steps and actions that can be taken. Each step and action will
cause the status of the translation item to be changed.
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The red letters indicate possible warning that could occur when applying a particular action to an item in
this state. The definitions of the warning are included in the table below.
Letter

Description

A

The translation may not be complete. Are you sure you want to approve it?

B

The item is already in translation.

C

The translation already exists. Do you want to overwrite?

D

The item has already been translated.

E

The translation is flagged as needing update. Are you sure you want to approve it?

F

If structural change has been created then an error is shown. See the section Considerations
when using Translation Manager for further details.

Translation project
The available statuses in Translation Manager for projects are included in the table below.
ID

Status

Description

1

In Perception
translation

New manual translation project

2

XML exported

New XLIFF translation project

3

XML imported

Translated XLIFF file is imported

4

Approved

Translation is reviewed and approved for delivery, meaning the user has
completed all the necessary translations

The following flow diagram highlights the steps and actions that can be taken. Each step and action will
cause the status of the translation project to be changed.
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The red letters indicate possible warning that could occur when applying a particular action to an item in
this state. The definitions of the warning are included in the table below.
Letter

Description

A

The translation may not be complete. Are you sure you want to approve it?

B

Are you sure you want to delete the translation project? Warning for individual items based on
their item status.

C

Check that the imported XML file includes the correct project ID, if not an error will be shown.
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Considerations when using Translation Manager
The translation of items can be a complex task. When translating items it is important to be aware of the
following:


Features that does not work with Translation Manager



Translating items using XLIFF



Translated items

Features that do not work with Translation Manager
Translation Manager does not work with the following features in Perception:
Feature

Description

Printing
and
Scanning

Translation Manager is not designed to work with Printing and Scanning in Perception. It is
not possible to identify language when using this feature.

Print to
It is not possible to Print to HTML or Word any translated assessments. This feature can only
Word/HTM work for the base language of the assessment.
L
Reporting

Reports on translated assessments are not available without first taking the assessment in
the base language. Please refer to the following Knowledge Base article for further details:
Why don't the results for an assessment I translated appear in reports?
www.questionmark.com/perception/help/v5/knowledge_base/troubleshooting/percept
ion_server/ts_ps519.aspx

Questionm It is not possible to deliver translated assessments using the Questionmark To Go player.
ark To Go Questionmark To Go can only be used to deliver the base language assessment.
Export to
QML

It is not possible to export the QML of a translated question.

Translating items using XLIFF
If you are translating a project by XML using the XLIFF format it is important to be aware of the following
when translating:


Perception keywords
Perception keywords are often used to provide specific information to the Perception Server and
could include information relating to the session, the server or URLs required. Generally this
information is dynamically created each time the assessment is run, so only appear as keywords in
the relevant XML files. These should NOT be changed or translated. Possible keywords are listed
below:


%SESSION.TITLE%



%SESSION.ID%



%SESSION.TIME%



%SESSION.TITLE%



ASSESSMENT_URL
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HTML tags
Perception stores the question stimulus, choice and feedback as HTML text so that they can be
formatted for display through a compatible web browser. When items are translated using XML the
HTML tags are included in the output. It is recommended that these are only altered if a change to
the format is required for the translation and that the person translating understands how to use
HTML tags because altered HTML tags not correctly formed could result in HTML tags appearing in
your translations. Some of the most common HTML tags are listed below:


<P> </P>



<B> </B>



<A ...> </A>

XLIFF applications use a particular mechanism to ease the translation of items including inline
formatting through the use of HTML tags. The mechanism leaves the formatting in place, but
embeds it inside a set of <bpt><ept> or <it> tags. The bpt and ept tags are used to mark up
paired formatting, with bpt surrounding the beginning formatting, and ept surrounding the ending
formatting. The <it> element surrounds non-paired formatting. In these cases, the characters "<"
and ">" need to be converted to their respective entities: &lt; and &gt;. For example, the tag
<img src="example.gif"> would be marked up as <it id="a1" pos="1">&lt;img
src="example.gif"&gt;</it>
The mechanism for identifying inline formatting using HTML tags is dependant on the
XLIFF application used. Some applications will automatically strip out all the HTML tags and store
them separately, others will include the HTML tags in the translation text, while others will use the
<bpt><ept> tags mentioned above.


Resource links
Resources are often included in questions and can be images, documents, links to web sites or
files. Resources like images, video and audio are commonly stored within the repository, while
other resources are links to other web pages and files. The references and links to the resources
are included in the output so that when translating the links and references can be changed to
point to relevant language specific versions of these resources.



Template references
Assessments can use templates to alter the format they are displayed. The template reference is
also included in an outputted XML file so that a specific localized template can be used if required.
It is important to ensure that the template chosen for the translation is available to the Perception
Server because an incorrect or missing template could cause issues when displaying the translated
assessment.

Translated items
The following section lists a number of factors that users should be aware about when using Translation
Manager. The factors are:


Changing exported base items



Copying items between repositories



Reporting on translated assessments

Changing exported base items
If a base question, topic or assessment has been structurally changed since:
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The initial translation



XLIFF export

You may find an error is caused when any subsequent import of the XLIFF is made or that the status of
the translated items reverts to Needs Updating.
A structural change for any translatable item is a non textual change to any of the structures that the
item can contain or the number of those structures. For example, structural changes include the following
scenarios:


Question wording fragment - e.g. the text containing a blank in a select a blank question or
text match



Question choice text - e.g. answer choices are changed for question include Select a Blank,
Ranking or Multiple Choice questions



Question choice options, including adding text to existing choices – e.g. Additional
options in a Select a Blank, Ranking or Knowledge Matrix question
Editing Ranking questions in Authoring Manager allows the removal of a question choice option
from one choice only. Doing just this is not counted as a structural change. However, editing a
Ranking question to remove the same question choice option from all of the options is counted as
a structural change. Removing a question choice option from one option in Select a Blank and
Knowledge Matrix question automatically removes the same question choice option from all the
question's options and is therefore a structural change.
For further information about question choices, please refer to the 'Questions' chapter of the
Authoring Guide for Perception 5.



Outcome conditions - if it has associated feedback
Adding new stimulus text does not constitute a structural change. This is the same as
editing the text of a question by adding text to the beginning or end of the question
text and so is counted as a textual change.



Topic outcome altered - e.g. when the number of topic outcomes is changed or any change to
maximum score of any of the topic's outcomes



Changes to an assessment - e.g. when the number of or the identity of any of the following
objects within the base assessment differs from the number or identity of those objects in the
assessment translations


Questions (see below)



Question blocks



Overridden assessment topic outcomes



Assessment outcomes
Editing the settings for an assessment outcome does not constitute a structural change,
this includes:


Email settings



Branching any assessment outcome field within edit settings



Adding a pre-requisite to an assessment outcome



Deleted question from an assessment - This will also remove the same question from all the
assessment's translations. This will move the translation status to Needs Update but as the
structure of the base and the translation is kept in step no structural change error will be displayed
when the import is attempted and only the questions that exist in the base will be translated



Added questions to an assessment - This will automatically add it to the translations of the
assessment if that question exists in the language of the assessment translation. In this case the
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assessment translation will only be flagged as Needs Update as both base and translation are
kept in step. This is true even if the added question has a translation status other than
Translated. The translation status of the added question is not important here; only that a
translation of it exists in the target language is important.
If the question you add to the base assessment has not been translated into a language that the
assessment has been translated into then that assessment translation will be out-of-step with the
base and on import a structural change error will be displayed.


Deleting a question block - This will also delete the same block from all translations of the
assessments. The base of the assessment and all its translations are kept in step so on import only
a Needs Update warning will appear
Adding a new question block to the base assessment is counted as a structural error on
import - as the new block will be added to the base and not to the assessment
translation(s).

Copying items between repositories
When translating items it is important to understand the affect this has on the item and its compatibility
with the rest of Perception. For example, when a translated question is cut and pasted or copied from a
shared repository to a local repository only the base question is copied not the translated contents. The
same is also true for assessments.
Reporting on translated assessments
It is only possible to report on a translated assessment if the assessment consisting of the base language
has been scheduled and delivered to a participant once before. This ensures that the results pertaining to
the translated assessment can be recorded in the database correctly.

Working with translated items in Qpacks
Topics, assessments and assessment folders can be exported from a repository to external files called
Qpacks. Qpacks are compressed files that have the default file extension .qpack4.
You can import Qpacks in both Authoring Manager or Browser-Based Authoring, but you can only create
Qpack files in Authoring Manager.
Qpacks created in Perception Version 4 are still compatible with Perception Version 5.
Language information is only included in a Qpack when the Qpack is exported from a shared
repository. It is not included when exported from a local repository. You should not, therefore,
export Qpacks containing translated items from local repositories.
Questions, topics and assessments imported into a shared repository will inherit the base language
settings of the topic chosen as the destination folder for the Qpack contents.

Editing questions created in Authoring Manager
Questions created with the Question Wizard in Authoring Manager can be edited with Question Manager
if they have not been altered manually, and they conform to the following specification.
Question type
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Can be edited with Question Manager if...

Question type

Can be edited with Question Manager if...

Multiple Choice



Only one content element for the question wording is present

Includes Yes/No, True/False
and Likert scale



No more than one graphic is included



The question wording, any choice text and feedback text all
contain entirely plain text or entirely HTML



Each choice has only one outcome



Only one content element for the question wording is present



No more than one graphic is included



The question wording, any choice text and feedback text all
contain entirely plain text or entirely HTML



Outcomes are structured as per the Question Wizard in Authoring
Manager



Only one content element for the question wording is present



No more than one graphic is included



The question wording, any choice text and feedback text all
contain entirely plain text or entirely HTML



All outcomes must have the accumulate option set (so that the
outcome scores are added)



No more than one content element for the question wording is
present



No more than one graphic is included



The question wording, any choice text and feedback text all
contain entirely plain text or entirely HTML



All outcomes must only have one string each (that is, they must
not contain OR or AND operators)



All outcomes must employ the same case sensitivity in matching
text



All outcomes must have MATCHES conditions, except the [OTHER]
outcome



There is only one [OTHER] outcome



No outcome has the accumulate option set (so that the outcome
scores are not added)



No more than one content element for the question wording is
present



No more than one graphic is included



The question wording, any choice text and feedback text all
contain entirely plain text or entirely HTML



Only one choice is present

Numeric

Multiple Response

Text Match

Essay
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Importing QPacks
QPacks contain topics and questions, and are a useful method of distributing questions. To import a
QPack into your repository, select Import QPack in the Question Options menu or Assessment
Options menu. This opens the Import QPack Wizard.

When importing a QPack you will need to:
1.

Specify the location of the QPack to import

2.

Accept the terms of the licensing agreement (this is only required if a license agreement was
specified when the QPack was created)

3.

Specify where in the repository the contents of the QPack are to be imported

4.

Confirm that you want to overwrite content in the repository with the contents of the QPack (this
is only required if the contents of the QPack will overwrite existing content in the repository)

You should also ensure that the QPack does not contain any topic with the same name as a topic already
residing in the repository. If this happens, the questions contained within the duplicate topic will not be
imported.
Language information is only included in a Qpack when the Qpack is exported from a shared
repository. It is not included when exported from a local repository. You should not, therefore,
export Qpacks containing translated items from local repositories.
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Overview
Questionmark Live is an On Demand authoring tools that lets you easily write questions and then export
them for use in Questionmark Perception. Subject Matter Experts (SMEs) can access this powerful
authoring tool anytime, anywhere. Questionmark Live is available free of charge to all Questionmark
Software Support Plan customers.
This chapter describes:


Accessing Questionmark Live



Creating questions



Importing questions from other systems



Sharing question sets between authors



Exporting questions and assessments

Accessing Questionmark Live
Questionmark Live lets you easily write questions and then export them for use in Questionmark
Perception. Subject matter experts (SMEs) can access this powerful authoring tool anytime, anywhere.
This Web-based application is available free of charge to all Questionmark Software Support Plan
customers signed up to Questionmark Communities.

Community account holders
To get access to Questionmark Live if you already have a Communities account:
1.

Click Questionmark Live on the Questionmark web site (in the My Questionmark menu)

2.

Enter your Questionmark Communities username and password when prompted

Non Community account holders
To get access to Questionmark Live if you do not have a Communities account:
1.

Click Questionmark Live on the Questionmark web site (in the My Questionmark menu)

2.

Click Become a new Community member

3.

Enter your details as required
The email address you use will need to have the same @domain.com address as the email
address that is registered in your SSP contract. For example, if jsmith@mycompany.com is the
registered contact in the SSP contract your email will need the same @mycompany.com domain
for access to be granted successfully at an organization level.

4.

Read the Questionmark Communities terms and conditions and place a tick in the checkbox to indicate that you agree with them

5.

Click Next > to continue the process

6.

In step 2 click Next > to skip adding information about a new license

7.

You will receive an email from customercare@questionmark.com containing your password and a
link to login to communities.
You can follow the instructions in the email to change your password.
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8.

Once you have logged in click Questionmark Live from the My Questionmark menu

Invited to use Questionmark Live
If you have been invited to share a Question Set from somebody you know using Questionmark Live you
will:
1.

Receive an email notifying you that someone has shared a Question Set with you

2.

Follow the link in the email to create your own Questionmark Communities account
(https://www.questionmark.com/communities/register.aspx)

3.

Log into Questionmark Live using your Communities email and password by:
a.

Navigating to the Questionmark web site

b.

Clicking Questionmark Live on the My Questionmark menu

c.

Entering your Questionmark Communities details when prompted
Or

a.

Navigating to https://live.questionmark.com

b.

Entering your Questionmark Communities username and password when prompted

4.

Click the Questions tab to access all your question sets, including those that have been shared
with you.

5.

Click the title of the Question Set to access its contents

Creating questions and assessments
The following section provides basic information on creating questions and assessments in Questionmark
Live. It is divided in to the following sections:


Adding a Question Set



Adding a Question



Creating an Assessment

Adding a Question Set
Questions are stored in Question Sets. These can be equated to Topics in Authoring Manager or BrowserBased Authoring.
To Create a Question Set:
1.

Click New

2.

Enter a name and description for the new Question Set

3.

a.

If you want to automatically share this Question Set with others who you have previously
shared a Question Set with place a tick in the Copy sharing from another Question Set
check-box

b.

Select the Question Set you would like to copy the sharing information from in the
Question Set drop-down box

Click OK to create the Question Set

Adding a Question to a Question Set
Now that a Question Set has been created you can add question to it. To do this:
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1.

Enter the Question Set by clicking on it from the Question Sets page

2.

Click New

3.

Select the required Question Type

4.

To create or edit the wording for your question, click where it says "Click here to change the
question wording" and enter the question wording. You can use the Text Formatting toolbar to
present the question wording in any way you wish.

5.

Depending on the chosen Question Type, you will need to ensure you have setup your choices and
scoring appropriately. For instructions about how to do this, please refer to the Help available
within the application.

6.

To add feedback to a question, click Show Feedback and include the necessary text.

7.

Add a question description. Question descriptions enable you to provide information on the
question being created. To add a description to a question, click Edit Question Description,
enter the description and click OK.

8.

Click Spell Check to check the spelling of the text contained in the question.

9.

Add a comment box. Adding a comment box to a question enables participants to provide a
response to the question. This is particularly useful when creating surveys. To add a Comment box
to a question, simply click Add Comment Box. The Comment Box will be added to the bottom of
the question. Once a Comment box has been added, you can edit the text used to introduce the
Comment box. By default this is "Add your comment:".

10.

Click Save to store your question.
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Creating an Assessment
Once you have created all your necessary questions you can compile them in to an assessment. To
create a assessment for use in Questionmark Perception:
1.

Click the Assessment tab.

2.

Click New.

3.

Click Assessment.

4.

On the Details tab enter a Title, Description and Introduction for the assessment.

5.

Click Next >.

6.

From the Select a Question Set drop-down box select a Question Set you are the owner off. The
questions contained in the Question Set will be included in the assessment.

7.

Click Next >.

8.

If you want to display feedback, place a tick in the Display Feedback check-box.

9.

If you want to use feedback you now have the option of setting a Pass/Fail mark by ticking the
Enable Pass/Fail check box and entering a Pass/Fail % in the text-box.

10.

Enter the necessary Pass and Fail feedback for the assessment. If you would like to provide links
to participants you can do this by entering appropriate Pass and Fail URLs

11.

Click Create Assessment
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With the assessment now created you can export it for use in Questionmark Perception.

Importing questions from other systems
Questionmark Live can also be used to import content from different platforms where they can be
viewed, modified, shared and exported as Qpacks. Questionmark Live can import the following types of
content:


LXR Test 6.1 Merge



Blackboard 6/8/9 Pool



Blackboard Upload



Questionmark Live CSV - The Questionmark Live CSV format is a new format specifically created
for Questionmark Live. It allows users to quickly create questions in Excel or other text tool that is
in the format of a CSV file. The CSV file can then be imported.



Questionmark Qpacks



Moodle XML

If you have questions available in any of the formats described above you can import them in to
Questionmark Live. The imported questions will be stored in their own Question Set. Where they can be
reviewed and modified. Once you are happy with your imported questions you can then export them as a
Qpack ready for use in Perception.
To import questions from other systems, complete the following steps:
1.

From the Question Sets page click Import Questions from the Import menu
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2.

Enter a Title and Description for the new Question Set

3.

Select the format of the questions you want to import from the Import Type drop-down list

4.

Click Browse

5.

Navigate to where you have saved the associated file you want to import. The file may be stored
in a folder on your computer or a network storage device

6.

Once you have located the file select it and click Open

7.

Click Upload

8.

Once the file has been uploaded to the Questionmark Live server the window will change to show
the file name of the file you uploaded in the Import File section of the window

9.

Click OK

A new Question Set will now appear in the list of available Question Sets with the title you provided when
importing the file. It is now possible to open the question set and view and edit the questions just as you
would any questions created directly using Questionmark Live.
To import questions from a Qpack:
1.

From the Question Sets page click Import Qpack from the Import menu

2.

Click Browse

3.

Navigate to where you have saved the associated file Qpack. The file may be stored in a folder on
your computer or a network storage device

4.

Click Upload

5.

Once the file has been uploaded to the Questionmark Live server the window will change to show
the file name of the file you uploaded the Question Set name where they will be stored and the
number of questions that will be imported. This information is shown in the Import File section of
the window

6.

Click OK

Sharing questions between authors
It is possible to share Question Sets with other users that are registered to use Questionmark Live. For a
quick way to share a Question Set:
1.

Select the Question Set you want to share by placing a tick in the check-box associated with it

2.

From the Share menu click Start Sharing
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3.

Enter the e-mail address or addresses of the users you want to share the Question Set with in the
Invite text-box (press the Enter key after each email address is entered)


4.

If you change your mind about who you want to share the Question Set with click the
Delete button to remove them from the list

Click Send (An email inviting the user(s) to share the Question Set is sent to the email addresses
indicated. If you would prefer not to notify the users that they can share the Question Set via
email click Share without sending invitation)


The Share without sending invitation link will only be available on email addresses that
you add which are already registered with Questionmark Live.



If you are attempting to share a Question Set with a user who is not registered with
Questionmark Communities they will automatically be sent an email providing instructions
about how to enroll and access Questionmark Live

Managing who your are sharing your Question Set with
To manage who has access to your shared Question Sets, click Manage... from the Share menu for a
selected Question Set.
Once in the Manage Sharing screen a list of the user currently sharing the Question Set is displayed. You
can un-share or add further sharing users by using the buttons available.
To add a new person to share the Question Set with:
1.

Click New Shared User

2.

Enter the e-mail address or addresses of the users you want to share the Question Set with in the
Invite text-box (press the Enter key after each email address is entered)


3.

If you change your mind about who you want to share the Question Set with click the
Delete button to remove them from the list

Click Send (An email inviting the user(s) to share the Question Set is sent to the email addresses
indicated. If you would prefer not to notify the users that they can share the Question Set via
email click Share without sending invitation)


The Share without sending invitation link will only be available on email addresses that
you add which are already registered with Questionmark Live.



If you are attempting to share a Question Set with a user who is not registered with
Questionmark Communities they will automatically be sent an email providing instructions
about how to enroll and access Questionmark Live

To un-share the Question Set with a specific user:
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1.

Select the user(s) who you do not want to share the Question Set with any longer by placing a tick
in the check-box next to their name

2.

Click Remove

3.

Click Yes

Assigning permissions
To assign permissions to a user you have shared your Question Set on the Manage Sharing screen, click
Manage Shared Permissions. The following permissions are available:


Shared – default level of sharing. When you share a question set with another user, they can only
edit or add new questions. Participants you share question sets with cannot delete questions from
a question set or download or email Qpacks.



Co-Owner – allows the user to download Qpacks, delete questions or question sets; and manage
sharing with other users



Read Only – The shared user can view shared question sets but cannot edit them



None – The person is kept in the owner's sharing list for reference purposes only

To Manage the Shared Permissions for a specific user:
1.

Select the user(s) you want

2.

Click the Manage Shared Permission button.

3.

Pick the level of permissions for the individual or group.

4.

Click the Save button.

Un-sharing a Question Set
To un-share a Question Set:
1.

From the Questions tab select the Question Set you want to stop sharing by placing a tick in the
check-box associated with it

2.

From the Share menu click Stop Sharing

3.

Click OK

This will stop all users, who previously had access, from viewing or editing the Question Set. To un-share
the Question Set for a specific user you will need to use the Manage... option from the Share menu, as
described above.

142

Exporting questions and assessments from
Questionmark Live
Question Sets and assessments can be exported to Qpacks. Qpacks can be used to import the content in
to a Questionmark Perception repository.

Exporting or emailing a Question Sets
To export a Question Set as a Qpack:
1.

Select the Question tab

2.

Select the Question Set you want to export by placing a tick in the check-box next to it (please not
that you can only export one Question Set at a time)




To download the Qpack:
a.

Click Download Qpack from the Export menu

b.

Click Save

c.

Specify a location in which you want to save the Qpack and click Save

To email the Qpack:
a.

Click Email Qpack from the Export menu

b.

Enter a To email address

c.

A Subject line for the email

d.

A Message to go along with the Qpack

e.

Click Send

Exporting an Assessment
To export an assessment as a Qpack:
1.

Select the Question tab

2.

Select the assessment you want to export by placing a tick in the check-box next to it (please not
that you can only export one assessment at a time)




To download the Qpack:
a.

Click Download Qpack from the Export menu

b.

Click Save

c.

Specify a location in which you want to save the Qpack and click Save

To email the Qpack:
a.

Click Email Qpack from the Export menu

b.

Enter a To email address

c.

A Subject line for the email

d.

A Message to go along with the Qpack

e.

Click Send
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Importing content
This chapter describes how authors can import question and assessment data ('content') into Perception.
This can help you to determine and implement a strategy for importing into Perception content stored in
formats such as QTI-XML, Blackboard, ASCii or Word.
It is divided into:


See "Choosing the right method" on page 145



See "Example scenarios" on page 149



See "Working with QTI XML files" on page 157



See "Converting to ASCII" on page 147



See "Importing content from ASCII files" on page 151



See "Importing and exporting Qpacks" on page 150



See "Copying between repositories" on page 148



See "Working with QML" on page 155

Choosing the right method
If you have content outside of your Perception repository, you can bring the content into Perception in
several ways. The method you can use will depend on the format of the content you want to import. If
your content is in the format described in the following table, there are tools available that will enable
you to import your content easily and quickly.
To import content from...
QTI XML files

One of the following systems:


Blackboard 6 and higher
zip files



LXR-Test 6.1



Moodle XML

ASCII files

Word-processor files

A different Perception version
4 repository
QML files

Then you can...
Import QTI XML files using Authoring Manager (refer to See "Working
with QTI XML files" on page 157 for details)
Use Questionmark Live

Use the ASCII Import tool in Authoring Manager (refer to See "Importing
content from ASCII files" on page 151 for details)
Use the ASCII Import tool in Authoring Manager (refer to See "Importing
content from ASCII files" on page 151 for details)
Copy content between repositories using Authoring Manager (refer to
See "Copying between repositories" on page 148 for details)
Import QML files using Authoring Manager (refer to See "Working with
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To import content from...

Then you can...
QML" on page 155 for details)

Perception version 4 QPacks

Import Qpacks using Authoring Manager or Browser-based Authoring
(refer to See "Importing and exporting Qpacks" on page 150 for details)

Perception version 3 databases Import version 3 databases can be done using the Shared Repository
Manager, please refer to the Shared Repository Help for your database
version:


SQL Server



Oracle

If your content is in a different format to that listed above, the options available to import your content
are as follows.
Option
Convert your
content to QTI
XML

Convert your
content to ASCII

Description
This option may be appropriate if you are using a tool that can convert your content to
QTI XML, or if you want to move your content into the QTI XML format. Once you
have converted your content to QTI XML, you can import the QTI XML files using
Authoring Manager (refer to See "Working with QTI XML files" on page 157 for details)
If you can add your content to Microsoft Word or a similar word-processing tool, you
can format the content and then save the file in ASCII format. This option may be
appropriate if your content is stored in word-processor format, or you are able to
manipulate the content in a word-processor.
Refer to See "Converting to ASCII" on page 147 for more information. Once you have
converted your content to ASCII, you can use the ASCII Import tool in Authoring
Manager. Refer to See "Importing content from ASCII files" on page 151 for details of
how to do this

Convert your
content to QML

Question Markup Language (QML) is used as the native language for describing
questions in Perception, and all questions are stored in the database as QML. You can
convert your content programmatically to QML format for importing into Perception.
This option may be appropriate if you have a large amount of similar questions in a
computerized format.
Once you have converted your content to QML, you can import your QML content into
Perception. Refer to See "Working with QML" on page 155 for more information

Add questions
individually into
Perception

This option may be appropriate if the amount of content you want to convert is
relatively small. In this case, you can use one of the Perception Authoring tools to add
content to Perception by Copying and Pasting the individual questions

See "Example scenarios" on page 149 provides some example importing situations that illustrate these
options.
If you are unsure which of the above options you should use, or would like the your content to be
imported into Perception for you, please contact the Questionmark Consulting Team. For more
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information, please refer to:
www.questionmark.com/support/consultingservices.aspx

Converting to ASCII
Question content that exists in word processor documents (such as Microsoft Word files) can be modified
to enable them to be imported into Perception. This section provides guidance on how to edit your word
processed documents so that question content can be imported into Perception using the ASCII Import
tool in Authoring Manager. This is done by replacing question numbering and answer options into
compatible tags by using the Find and Replace operation. In the example provided below, we use
Microsoft Word 2003 as the example word processor. However, similar functions are available in other
versions of Microsoft Word as well as Word Perfect and other word processor software.

Example
To convert question content in a word processor document, you will need to Find and Replace the
question marker text used with the marker text required by the ASCII Import tool in Authoring Manager.
For example, you may be using the following style of formatting in your word processor file:
For questions: <number><period><question>
For answers: <tab><letter><bracket><space><answer>
This is shown in the example word processor document below (formatting marks shown).

To modify the above marker text so that it can be imported into Perception:
1.

Select Replace from the Edit menu

2.

Click More to display the advanced options

3.

Click Special and select Tab character from the list

4.

Click Special again and select Any letter from the list

5.

Add a right bracket character and a space character to the Find What: box

6.

In the Replace with: box, enter <C>
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7.

Click Replace all

8.

Delete the content In the Find What: box

9.

Click Special and select Any Digit from the list

10.

Add a period character (.) and a space character and click Replace all

11.

The document will now be correctly formatted

12.

Finally, to specify the correct answers you will need to change the <C> Choice marker to <C+>
for each question.

Copying between repositories
If you have access to both repositories, you can import content from one Perception repository to
another with the Copy/Paste or Drag and Drop operation in Authoring Manager. By doing so, you can
copy any topic, assessment, template, content or resource object in a repository to another.
If you do not have access to both repositories, you will need to export the content from the source
repository as a Qpack. You will then need to import the Qpack into the target repository. Refer to
Importing and exporting Qpacks for more information.
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Example
In the following example, we will copy an assessment from one repository to another. However, the
process is the same if you are copying individual questions, topics containing questions, assessment
folders, templates, or content and resource objects.
1.

Start Authoring Manager and open both the source repository containing the assessment you want
to copy and the target repository in which you want to copy the assessment

2.

In the source repository, right-click the assessment you want to copy and select Copy

3.

In the target repository, right-click the assessment folder in which you want to copy the
assessment, and select Paste

4.

The assessment and all the content associated with it will be copied to the target repository. If
doing so will overwrite any existing files in the target repository, you will be asked to confirm the
operation. Note that this operation cannot be undone

You can perform the same operation by using the Drag and Drop method. In the above example, instead
of right-clicking the assessment you want to copy and selecting Copy, you can instead drag the
assessment and drop it in the assessment folder of the target repository in which you want to copy it.

Example scenarios
The following example scenarios discuss the different options available to import content into Perception
in different circumstances.
Scenario
Jeff is a corporate manager who
has an old UNIX custom system

Suggestions
There is too much content in Jeff's database to add questions
individually into Perception. Therefore, Jeff will need to convert the
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Scenario
for delivering questions with
3,000 multiple choice questions
in an old style database format

Suggestions
content programmatically to QML format for importing into
Perception. This is particularly appropriate if there is a large amount
of similar questions, such as multiple choice questions.
Once the database has to converted to QML, Jeff can import his QML
content directly into Perception. Refer to See "Working with QML" on
page 155 for more information

Jane is a university lecturer who
has some free questions from a
publisher in Blackboard format

If the Blackboard system is version 6 or above, and she has access to
the system, Jane can create Blackboard 6 and higher zip files
containing her questions. She can then use Questionmark Live to
import the questions, edit them and export them to the Qpack format.
Once the Blackboard questions have been turned into Qpacks, they
can then be imported into Perception in the standard way. Refer to
See "Importing and exporting Qpacks" on page 150 for more
information

Carlos is a manager at an
awarding body who has a test of
50 questions in Word format

Carlos has two options:


If the questions use a standard format, he can quickly format
the questions so that the file can be converted to ASCII. This is
done by replacing question numbering and answer options into
compatible tags by using the Find and Replace operation. Once
he has converted his Word file to ASCII, Carlos can use the
ASCII Import tool in Authoring Manager to import the content
directly into Perception



If the questions do not use a standard format, formatting the
questions so that the file can be converted to ASCII may be
more complex than simply adding the 50 questions individually
into Perception. Carlos could use Authoring Manager, Browserbased Authoring or Questionmark Live to accomplish this

Importing and exporting Qpacks
Topics, assessments and assessment folders can be exported from a repository to external files called
Qpacks. These are compressed files that have the default file extension .qpack4. You can import Qpacks
in both Authoring Manager or Browser-based Authoring, but you can only create Qpack files in Authoring
Manager.
If you have access to both repositories, you can import content directly from one Perception
repository to another with the Copy/Paste or Drag and Drop operation in Authoring Manager. This
process can be quicker than importing and exporting a Qpack file containing the same
information. Refer to See "Copying between repositories" on page 148 for more information

Exporting Qpacks
With the Export Qpack Wizard in Authoring Manager, you can create Qpacks that contain:
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Topics, assessments or assessment folders



Any resources or templates associated with these topics, assessments or assessment folders

When you export a Qpack, you can also specify which of the questions included in the Qpack the author
importing the Qpack can edit. To export a Qpack:
1.

Open Authoring Manager and connect to the repository containing the content you want to export
as a Qpack

2.

Highlight the topic, assessment or assessment folder that you want to export to a Qpack

3.

Select File | Import/Export | Export to Qpack…

4.

Follow the instructions given in the Export Qpack Wizard

Importing Qpacks
You can import Qpacks in both Authoring Manager or Browser-based Authoring.
For instructions on how to import Qpacks with Browser-Based Authoring, refer to See "Importing QPacks"
on page 134.
To import a Qpack with Authoring Manager:
1.

Open Authoring Manager and connect to the repository in which you want to import the Qpack

2.

Select File | Import/Export | Import from Qpack…

3.

Follow the instructions given in the Import Qpack Wizard

Importing content from ASCII files
Question content in ASCII files can be imported into Perception with the ASCII Import tool in Authoring
Manager. This chapter contains information on how to import content in ASCII files into Perception.
Marker codes are used in ASCII files to define question elements such as question type, question text,
correct answer choices, incorrect answer choices, and feedback text. Click Here to view an example ASCII
file containing three questions.
This section is divided into:


Importing questions with the ASCII Import tool



ASCII Import definitions

For information on how to convert content to ASCII format, please refer to See "Converting to ASCII" on
page 147.
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Importing questions with the ASCII Import tool
To import question content into Perception from an ASCII file:
1.

Ensure that the marker codes used in your ASCII files are compatible with the marker codes that
have been defined in Authoring Manager. For information on the marker codes defined in
Authoring Manager, refer to ASCII Import definitions

2.

Ensure that the ASCII file has a .txt file extension, and is in Unicode format

3.

Open your repository in Authoring Manager

4.

Under Folder Views, select Questions view

5.

Highlight the topic into which you want to import the question content and select Manage Items
| Import | Import ASCII…

6.

The Import Questions from ASCII screen is displayed

7.

Select the ASCII file that contains the questions you wish to import and click Open

8.

If any new topics or subtopics will be created by importing the new question content, you will be
asked to confirm that you want to create them

9.

The questions in the ASCII file are imported and the imported questions will appear in the
highlighted topic

ASCII Import definitions
The definitions used by the ASCII Import tool and the default marker code values are described in the
table below.
Unless you specify otherwise, the ASCII Import tool will import the ASCII file using the default marker
codes for the ASCII import definitions. Refer to Modifying marker codes for information on how to modify
these codes.
Marker
code
<TOPIC>
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Definition
Topic Name

Description

Inserted in front of the name of a question topic. Specifies the name of the

Marker
code

Definition

Description
topic or subtopic in which to import the question content. If the topic or
subtopic does not exist, you will be asked to confirm that you want to create
the topic or subtopic. Authors can only import questions into a topic or
subtopic if they have the permission to do so
The use of this code is optional. If not used for a question, the question will
be imported into the topic or subtopic selected in Authoring Manager.
This code is inserted in front of the name of a question topic. Double
backslashes (\\) are used to separate the names of topics and subtopics. For
example:
<TOPIC>Geography\\Mountains
The following errors will cause the file to be rejected and an error message
displayed identifying the problem:
Invalid topic or subtopic names
topic or subtopic names of more than 50 characters
illegal characters
Subtopics of more than 10 levels deep

<Q>

Start of
Question

Inserted in front of the text of the question. For example:
<Q>The tallest mountain in the world is:

<C+>

Correct choice
(scores 1)

Inserted in front of the text of the correct answer choice. For example:
<C+>Mount Everest
This import definition scores +1

<C>

Incorrect or
distractor
choice (scores
0)

<C->

Incorrect or
distractor
choice (scores
-1)

<F>

Feedback for
choice

Inserted in front of the text of an incorrect choice. For example:
<C>Mont Blanc
This import definition scores 0
Inserted in front of the text of an incorrect (negative) choice. For example:
<C->Mont Blanc This import definition scores -1

Inserted in front of question feedback text. For example:
<F>Mount Everest is the tallest mountain in the world

<D>

Question
description

Inserted in front of the question description text. For example:
<D>Typical Multiple Choice Question
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Marker
code

Definition

Description
Description text is not displayed to participants

<T>

Set Question
type

Inserted in front of the question type. The following question types can be
imported in ASCII question data:


MC - Multiple Choice



MR - Multiple Response



YN - Yes/No



TF - True/False



LKS - Likert Scale



E - Explanation

For example:
<T>MC
<S>

Tag prefixing
to set define
shuffling
choices

<M>

Tag prefixing
Mime type
plain or HTML

<#>

Comment
(Lines
following this
not imported)

Inserted above a question in the question data. All questions from that point
on will have their choices shuffled

Inserted in front of the MIME type. For example:
<M>text/plain
Inserted in front of comment text. For example:
<#>
This is a sample Multiple Choice Question Comment text is not displayed to
participants

Modifying marker codes
To customize the marker codes used for importing questions from ASCII:
1.

Open your repository in Authoring Manager

2.

Select Tools | Question ASCII Import Definition

3.

Specify the marker codes to be used
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Refer to ASCII import definitions for more details on the ASCII Import definitions
4.

Click OK

Working with QML
Question Markup Language (QML) is a platform-independent language that describes questions for use in
tests and assessments. It is an open standard and as such is freely available for anybody who wishes to
use it. QML offers an extensible solution that is precise, flexible and easy to use. Anybody who has
mastered HTML should feel comfortable with QML.
QML is used as the native language for describing questions in Perception, and all questions are stored in
the database as QML. The Perception repository stores QML, and Authoring Manager and Enterprise
Manager work directly with the QML stored in the repository. QML is defined by Questionmark and is
XML-compliant. Only individual questions are described by QML and each question is independent of any
other. Assessments cannot be defined by QML, and nor can the sequencing of questions (for example,
branching, jumps and selection of questions at random for a test). However, any number of questions
may be defined in the same QML file.
This section contains information on:
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Exporting and importing QML files



QML structure

Exporting and importing QML files
Question content saved as QML can be exported from and imported to Authoring Manager using the
Import option under Manage Items.

QML structure
The root element in a QML file is <question>. The root element can contain the following child elements:
Child
element

Description

<Tag>

Contains information on the classification of a question item

<Comment>

Contains annotation and comments on questions

<Content>

Contains all the material presented or made available to the participant

<Answer>

Contains the different responses to the question made available to the participant.
Responses are contained within one or more <Choice> child elements

<Outcome>

Contains the score to set and what feedback to display, depending on the choice or
choices selected

For more information on QML, please refer to the Knowledge Base article:
What is QML?
www.questionmark.com/perception/help/v5/knowledge_base/authoring/importing_and_exporting_
content/content502.aspx
Click here for the XSD schema for QML.
www.questionmark.com/schemas/
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Working with QTI XML files
The IMS have published a specification for QTI XML, the XML question and test description language. Full
details of the IMS specification can be found at:
www.imsproject.org/question
Perception is compliant with version 1.2 of the IMS QTI specification. In other words, Perception authors
can use Authoring Manager to import question content from QTI XML files and export them to QTI XML
files. In Authoring Manager, this can be accomplished by using the Import option under Manage
Items.

The following question types can be imported and exported as QTI XML:


Multiple Choice



Multiple Response



Numeric



Pull-down list



Fill in Blanks



Matrix



Essay



Matching



Ranking



Select a Blank



Macromedia Flash

Only individual questions can be imported or exported in QTI XML files, and each question is independent
of any other. Assessments cannot be defined by QTI XML, and nor can the sequencing of questions (for
example, branching, jumps and selection of questions at random for a test). However, any number of
questions may be defined in the same QTI XML file.
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Workflow
Workflow provides a simple and effective means of controlling the development of questions. This control
is achieved through the creation and implementation of a process that ensures the needs of an
organization are fully met. The process is defined as an individual workflow which workflow
administrators can manage using the Workflow Editor in Authoring Manager.
Questionmark can create custom workflows for organizations. These workflows can ensure that
the processes of authoring within the organization are quickly put in place and reliably enforced.
Please contact the Questionmark Technical Services Team for more information.
This chapter provides an overview of workflow, and is divided into:


See "What is workflow?" on page 159



See "Workflow structure" on page 160



See "Managing workflow" on page 161



See "Example workflow" on page 162

What is workflow?
This section introduces what workflow is and how it works.
In a workflow, questions progress from an authoring stage, through various approval stages, to the
production stage where the question can be included within assessments. To implement a workflow, you
must create a new root topic in your repository that uses the workflow. The workflow is applied to all
questions in the new root topic or subtopics.
Authors (that is, users of Authoring Manager) can be provided permissions by allocating them to roles. An
author's role determines the questions they can see, and what they can do with them. Actions can be
applied to questions to move them from one stage to another by users who have the required
permissions.
The most common actions are the Accept action and the Reject action. These are the basic actions in any
workflow, although it is possible to use more descriptive names that are meaningful for the workflow.
A question that is subject to a workflow will always be at one of the stages defined in the workflow.
Authoring Manager displays both the workflow and the current stage for all such questions. The question
will be assigned a delivery status that is defined in the stage, and Authoring Manager also displays this
for the question.
Workflows can be distributed between shared repositories by using the Import Workflow and
Export Workflow options in Authoring Manager. Refer to the Authoring Manager Help for
instructions.

Workflow permissions
The actions an author can perform on questions are controlled by the access rights specified for a shared
repository. A workflow can impose further restrictions on authors' actions. However, these additional
restrictions only apply to authors when they are working with a question in a topic that has a workflow
assigned to it.
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An administrator can never do more than their access rights permit, even if workflow permissions
imply otherwise. The security set in a shared repository always takes precedence over workflow
permissions.
Workflow permissions determine what authors can do with questions according to both the stage the
question is in and the restrictions applied by security. When a question is in a particular stage:


The stage will have one or more actions that have this stage as their From Stage



Each of these actions have one or more roles assigned to it



Each of these roles have one or more administrators belonging to it

The stage will therefore have one or more administrators associated with it.
The permissions available for roles are:


Edit permission - Authors can edit questions that are in the relevant stage



View permission - Authors can view questions that are at the relevant stage



Delete permission - Authors can delete questions that are at the relevant stage



Create permission - Authors can create questions that are at the authoring stage

Designing a workflow
When designing a workflow, you should consider the following issues:
Issue

Description

Testing your
design

It is important to consider your design carefully and ensure that it provides a process
that meets your organization's requirements. We recommend that you test your
workflow thoroughly before making it live.

Changing a
workflow

When a workflow is live, it is difficult to predict the effect of changing it. You should take
care when updating a workflow that is in use.

Defining roles

When you define a role in a workflow, it is associated with the shared repository rather
than the workflow itself. This means that all roles are available to all workflows, and so
every role in the shared repository will appear in each workflow. For this reason, we
recommend that you think carefully about your roles and what they will be used for.

Setting
security
permissions

Security permissions in a workflow impose restrictions on users further to those defined
by access rights. However, the workflow permissions can never enable users to do
anything that their access rights do not allow. You must bear this in mind when
extending your security restrictions with a workflow.

Workflow structure
This section defines the terms that are used when working with workflow, and provides an outline of how
workflows are structured.
A workflow consists of three components:


Stages - The steps through which a question passes



Actions - The means by which a question passes from one stage to another



Roles - The definition of who may perform an action
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Stages
The stages in a workflow are the steps through which a question passes. A question passes from one
stage to another by means of an action. A workflow stage has the following attributes:


Name



Description



Delivery status

A question in a topic under a workflow passes through three types of stage:
1.

Authoring - the stage a question is at when it is created

2.

Approval - stages the question passes through as it is developed, and before it is approved for use
in assessments

3.

Production - the stage of a question that is ready to be used in an assessment

Actions
A question in a topic under a workflow passes from one stage to another by means of an action. There
may be one or more actions between one stage and another.
Roles define who may perform an action, and may be performed by one or more administrators. What
administrators can do with a question in a topic under a workflow is controlled by permissions.

Roles
Roles define who may perform an action. A workflow role has a name and a description and may have
one or more administrators assigned to it. When a role is defined, it is available throughout the
repository. A role can be used in more than one workflow.
It is possible to set permissions for each of the roles associated with a stage. This means that what can
be done to questions by authors with particular roles will depend on:


The stage the question is at



The restrictions applied by security

Managing workflow
Workflow administrators can use the Workflow Editor in Authoring Manager to:


Create a new workflow



Edit an existing workflow



Rename a workflow



Delete a workflow

The Workflow Editor enables workflow administrators to create stages, define actions between stages,
create the roles associated with actions, assign administrators to roles and set permissions for roles for
specific stages.
Once a workflow administrator has created a workflow, a root topic can be created using the workflow.
The workflow will then be applied to all questions in the new root topic or in topics below the new root
topic.
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As a question is developed, the workflow administrator can apply an action that changes the stage of the
question in the workflow. Refer to Example workflow for a real-life example of using a workflow.
It is also possible for workflow administrators with sufficient rights to change a stage
independently.
You can move a workflow between shared repositories by exporting a workflow from one shared
repository and then importing a workflow to another shared repository. When exporting a workflow, the
workflow administrator creates a workflow archive which is a file with the extension .wml. These files can
be used for archiving workflows.
For instructions on how to use Authoring Manager to control workflow, please refer to the Authoring
Manager Help that accompanies the application

Example workflow
The following example describes a workflow named Simple.

This example will show how the activities of two authors (Author 1 and Reviewer 1) are controlled by the
Simple workflow. Three stages are created:


New Question



Draft for Review



Under Revision
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Author 1 is given the following authoring access rights.

Reviewer 1 is given the following authoring access rights.

The workflow administrator creates a root topic with workflow and creates a topic called Statistics which
is assigned the Simple workflow.
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The workflow administrator then assigns the following access rights to the Statistics topic for Author 1
and Reviewer 1.

This specifies that Author 1 and Reviewer 1 will be able to do anything with any question in the Statistics
topic (unless the Simple workflow applies restrictions).
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In the Simple workflow, Author 1 is a member of the Authoring role, and Reviewer 1 is a member of the
Reviewing role. The three stages in the workflow ( New Question, Draft for Review and Under Revision)
have the following permissions set for them.
Role

Stage
New Question

Authoring

Reviewing



View



Edit



Create



View

Draft for Review Under Revision




View

View



View



Edit



View

This means that:


Author 1 (who is a member of the Authoring role) can only edit questions if they are in the stages
New Question and Under Revision



Reviewer 1 (who is a member of the Reviewing role) can never edit questions if they are in any of
these stages

In this way, the Simple workflow has applied restrictions to the access rights initially set up in the shared
repository for Author 1 and Reviewer 1. These restrictions only apply to the Statistics topic or any other
topic with the Simple workflow assigned to it.
Finally, the actions Compose and Revise can only be applied by members of the Authoring role, and the
actions Accept and Reject can only be applied by members of the Reviewing role.
The following sequence of events might now take place:
1.

Author 1 logs in to the shared repository and creates a question called Poisson Distribution

2.

Author 1 then applies the action Compose, so the question Poisson Distribution moves to the stage

Draft for Review

At this point, Author 1 cannot edit the question because it is in the workflow stage Draft for
Review, and nor can they apply any further workflow actions
3.
4.

Reviewer 1 logs in to the shared repository and attempts to edit the question, but cannot because
they belong to the role Reviewing whose members are not allowed to do this
Reviewer 1 applies the action Revise, so the question moves to the stage Under Revision

5.

Author 1 can now edit the question

6.

Author 1 edits the question and applies the action Revise, so the question moves to the stage

7.

Reviewer 1 can then apply the actions Accept or Revise

8.

The process continues until Reviewer 1 applies the action Accept to the question when it is at the
stage Draft for Review

Draft for Review

When Reviewer 1 does this, the question moves to the stage Draft for Approval
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Appendix
The Appendix contains technical information on:


See "Finding more information" on page 167



See "Frequently Asked Questions" on page 169



See "Contacting Questionmark" on page 169

Finding more information
This section contains a list of useful resources on the following subjects:


Authoring Manager



Enterprise Manager



Enterprise Reporter



Templates



Workflow

Authoring Manager
For detailed instructions on installing Authoring Manager, please refer to the Authoring Manager Install
Guide.
If you are new to Authoring Manager, we recommend that you read the Getting Started Guide, which
contains information on how to get started and quickly become productive with Authoring Manager.
For detailed guidance on how to use Authoring Manager to perform specific tasks, please refer to the
Online Help that can be accessed from within the Authoring Manager application.
To access the Online Help for Authoring Manager, press the F1 key, or select Help > Contents from the
File menu.
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Enterprise Manager
For more information on Enterprise Manager, please refer to the Enterprise Manager User Guide.
This guide is available to members of Questionmark Communities and is located on the Perception
Product Support site:
www.questionmark.com/perception/help/v5/product_guides/
Additionally, comprehensive guidance on how Perception administrators can use Enterprise Manager can
be found in the Help that accompanies the product.

Enterprise Reporter
For more information on Enterprise Reporter, please refer to the Enterprise Reporter User Guide.

Templates
For more information on using templates to present assessments, please refer to the Templates
Reference Guide. This guide contains comprehensive guidance on how to modify and create template
files that can be used to present assessments that fully conform to your requirements.
The Templates Reference Guide is available to members of Questionmark Communities and is located on
the Perception Product Support site:
www.questionmark.com/perception/help/v5/product_guides/

Workflow
For instructions on how to use Authoring Manager to control workflow, please refer to the Authoring
Manager Help that accompanies the application
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Frequently Asked Questions
The following table answers some of the most frequently asked questions on authoring assessments.
Question

Answer

Where can I obtain the
latest version of
Authoring Manager?

The latest version of all Questionmark applications can be obtained from the
Downloads area of the Questionmark web site.

How do I make
assessment folders in
Browser-Based
Authoring?

You cannot make assessment folders in Browser-Based Authoring. Instead,
you have to create the assessment folders in Authoring Manager, and then
they can be used within Browser-Based Authoring in Enterprise Manager.

How can I contact
Questionmark?

Please refer to See "Contacting Questionmark" on page 169 for details.

www.questionmark.com/download

Contacting Questionmark
If you have a technical problem with Perception that you cannot resolve, please contact Questionmark
Technical Support. Contact details are provided in the table below.
Area

Technical Support phone

US

800-597-3950

UK

+44 (0)800 731 5895

Europe

+32 (0)2 398 02 05

Rest of World

+44 (0)800 731 5895

Technical Support Email
support@questionmark.com

If you have a licensing query, please email the Questionmark Customer Service team. Please refer to the
full list of Questionmark Sales Offices for the contact details of your nearest office. This list can be found
on the Questionmark web site:
www.questionmark.com/sales_offices.aspx
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